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Preface

Your ColorScript 310/330 Printer
Thank you for purchasing your QMS ColorScript 310/330 
printer. Using either the ColorScript 310 or the The ColorScript 
330, you can easily produce photo-realistic 24-bit, 300-dpi color 
prints from a variety of Macintosh, Windows 3.1, and 
Windows 95 applications. 

The ColorScript 310/330 is a dye sublimation thermal transfer 
printer. It operates by evaporating colored dye from a Mylar 
ribbon and transferring it onto special paper stock or 
transparency film. Multi-color prints pass the thermal print head 
once for each primary color in the print.
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Both ColorScript printers handle a wide variety of paper and 
transparency film sizes:

◆ The ColorScript 310 prints to various paper or transparency 
film sizes, including A5, A4, A, and Super A 

◆ The ColorScript 330 prints to various paper or transparency 
film sizes, including A4, A3, A, Super A, B, and Super B

Other ColorScript 310/330 features include:

◆ Memory expandable to 128 MB

◆ An internal 540 MB hard disk

◆ Easy connection to additional, external hard disk drives

◆ Connectivity using LocalTalk, Thinnet Ethernet, 10Base-T 
Ethernet, Parallel, and SCSI interfaces 

Intended Audience
This User’s Guide is for pre-press and graphic design 
professionals who will use the ColorScript 310/330 printer to 
produce accurate color proofs of print jobs before going to 
press.

This manual provides illustrated, step-by-step instruction on 
creating proofs with the ColorScript 310/330 printer from a 
variety of applications. ColorScript 310/330 printer users should 
have sufficient computer knowledge to control their various 
hardware devices, operating system software, and graphics 
applications.
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Description of Contents
Chapter 1, “Installing Your Printer”

Here you’ll learn about unpacking the ColorScript 310/330 
printer, and connecting the printer to your computer. 

Chapter 2, “Loading Paper and Film”

This chapter covers loading paper or transparency film into the 
paper cassette and manual feed tray.

Chapter 3, “Changing Printer Ribbons”

This chapter describes how to change the ink ribbon.

Chapter 4, “Printing from the Mac OS”

This chapter describes the installation of the ColorScript 310/
330 printer software, and printing from some of the more 
popular graphics and page layout applications for the Macintosh 
Operating System, including:

◆ Macromedia Freehand 5.5

◆ Adobe Illustrator 6.0

◆ Adobe PageMaker 6.0

◆ Adobe Photoshop 3.0.5

◆ Quark Express 3.3

Chapter 5, “Printing from Windows”

Here you’ll find out how to set up the ColorScript 310/330 
printer in Windows 3.1 and Windows 95. This chapter also 
details printing from the following Windows-based graphics and 
page layout applications: 

◆ Macromedia Freehand 5.5

◆ Adobe Illustrator 4.0
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◆ Adobe PageMaker 6.0

◆ Adobe Photoshop 3.0.5

◆ Corel Draw 5.0 (in Windows 3.1)

◆ Corel Draw 6.0 (in Windows 95)

◆ Quark Express 3.3

Chapter 6, “Upgrading Your Printer”

This chapter provides instructions for upgrading printer 
memory, adding external hard disk capacity, and setting up 
SCSI printing.

Chapter 7, “Storing and Ordering Supplies”

This chapter describes how to store printer supplies and prints, 
and how to order new printer supplies.

Chapter 8, “Maintaining and Troubleshooting Your Printer”

This chapter includes instructions for cleaning and servicing the 
printer, explanations of printer controls and indicators, and a 
troubleshooting section describing error messages and situations 
which may come up while printing from Windows 3.1, 
Windows 95, and the Macintosh Operating System.

Appendix A, “Technical Specifications”

Technical specifications for the ColorScript 310/330 printer 
include physical specifications and input and output capabilities.

Glossary

The glossary defines the fundamental terms associated with 
printer operation.

Index

Major terms and concepts are referenced in the Index.
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1
Installing Your Printer

Finding a Location for the Printer
Place the printer on a flat, stable surface with adequate 
ventilation, away from dust and airborne grit. Also avoid drafts, 
particularly near air conditioning ducts. Provide at least two 
inches of clearance between the printer and walls or cabinets.

NOTE: The ColorScript 310/330 printer is designed for use in a 
normal office environment. The maximum operating temperature 
range for the printer is 50° to 95° F (10° to 35°C). Temperatures 
outside this range may adversely affect print quality and printer 
operation.
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Unpacking the Printer
The instructions in this User’s Guide are written to ensure 
trouble-free setup and installation. Please take time to carefully 
read and follow all steps in this chapter.

To unpack the ColorScript 310/330 printer:

1. Remove the various accessories and packaging materials 
from the shipping carton.

Remove the tape strips used to secure loose parts during 
shipping. Do not throw away the packing materials. You can 
use them again to transport the printer in its original box.
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Figure 1-1  ColorScript 310/330 Packing Materials

NOTE: In addition to the materials that ship with the printer, you 
will need a printer cable suitable for your computer. See “Connecting 
the Printer Cable” on Page 9 to determine what type of printer cable 
to use. 

2. With a partner, carefully lift the printer from its box 
onto a suitable table or desk. 

Cardboard Box

Divider

Cardboard Box

Dye Ribbon

Padding

Padding

Printer with
Ribbon Cassette

Accessories:

• Paper Cassette
• Paper Stopper
• Power Cord
• Paper
• Head Cleaning Kit
• User’s Guide



Chapter 1 — Installing Your Printer

4

WARNING: At nearly 100 pounds, the printer is too heavy to lift 
by yourself without risk of injury or damage to the printer. Take care 
to team-lift the printer when unpacking, and use care to avoid injuring 
your hands or fingers when repositioning the printer on a table top.

3. Remove the cardboard padding from the paper cassette.

A piece of cardboard is used to pad the paper cassette 
during shipping. Refer to Chapter 2, “Loading Paper and 
Film,” for detailed instructions on opening the paper 
cassette.

4. Remove all packing materials from the printer.

Pull the printer cover switch toward the front of the printer 
to open the printer cover, and remove the padding material 
from the ribbon cassette area. Refer to Chapter 3, 
“Changing Printer Ribbons,” for details about the ribbon 
cassette.

5. Familiarize yourself with the parts of the printer and 
paper cassette.

See Figure 1-2, Figure 1-3, and Figure 1-4 to identify the 
major parts of the printer and paper cassette.
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Figure 1-2  ColorScript 310/330 Printer Parts (Front View)

Figure 1-3  ColorScript 310/330 Printer Parts (Rear View)
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Figure 1-4  Paper Cassette Parts
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Setting the Printer Voltage Switch
Before turning the printer on for the first time, confirm that the 
voltage switch setting matches the electrical current within your 
facility. Your ColorScript 310/330 printer voltage switch should 
already be set to the correct voltage for your country. See 
Table 1-1 to determine the correct voltage setting for your 
country.

The voltage switch is recessed into the printer’s rear cover, 
directly above the AC power receptacle. If you need to change 
the voltage settings, use a flat-bladed screwdriver to flip the 
switch to the left for 100 - 120 Volts AC, or to the right for 220 - 
240 Volts AC. You may need a strong light or flashlight to read 
the numbers printed on the printer voltage switch.

Figure 1-5  Setting the Printer Voltage Switch

Table 1-1  Voltage Settings in Selected Countries

Country Voltage Setting Country Voltage Setting

Europe 220-240 Volts AC United States 100-120 Volts AC
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Connecting the Power Cord
Once you confirm that the printer’s voltage setting matches the 
electrical current within your facility, you may connect the 
power cord to the printer and a three-pronged, grounded power 
outlet. 

WARNING: Be sure to use the three-pronged electrical plug 
supplied with the ColorScript 310/330 printer, and do not alter the 
plug in any way. If your facility does not provide three-wire grounded 
power receptacles, the power outlet should be upgraded to a three-
pronged, grounded outlet. Do not use a two-pronged grounding 
adapter to plug your printer into a two-pronged outlet. 

To connect the power cord:

1. Verify that the printer’s power switch on the front of the 
printer is in the OFF position.

The “°” on the lower half of the switch is flush with the 
switch moulding when the power is off.

2. Insert the receiver end of the power cord into the 
receptacle in the rear of the printer. 

3. Connect the three-pronged end of the power cord to a 
properly grounded power outlet.
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Connecting the Printer Cable

WARNING: Turn the printer and computer OFF before 
connecting the printer to your computer. 

The ColorScript 310/330 printer provides five different 
computer connections, shown in Figure 1-7:

◆ LocalTalk (Macintosh printer cable)

◆ Thinnet Ethernet (Coaxial cable)

◆ 10Base-T Ethernet (Category 5 cable)

◆ Parallel (PC parallel port cable)

◆ 50-pin High-density SCSI (SCSI-2 cable)

Figure 1-6  Typical Printer Connectors

NOTE: The large 50-pin SCSI port on the back of the printer is 
used exclusively for connecting dedicated external hard disks to your 
printer. No devices connected to this SCSI port can be used by the 
host computer. 

50-pin HD-SCSIParallel Port10Base-T
Ethernet

Thinnet
Ethernet

Localtalk
(SCSI-2)
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Macintosh users:Use a LocalTalk or Ethernet connection for best 
results.

IBM-compatible PC users:Use a parallel port or Ethernet 
connection for best results. Do not use the serial connection; at 
9600 baud, the serial port is too slow for printing large files.

SCSI Printing for Specific Applications:Some applications, such as 
Adobe Photoshop, support SCSI printing through special Raster 
mode SCSI printer drivers. When using the SCSI printer driver, 
you can speed up printing from Raster (bitmap) applications like 
Adobe Photoshop by printing to the ColorScript 310/330 printer 
by a SCSI connection.

Consult your computer’s documentation or your system 
administrator if you are not sure what type of connection is right 
for your computer or your network.

Figure 1-7  Printer Cable Connections

36-pin Parallel
HD-50-pin SCSI

25-pin Serial

50-pin SCSI 

LocalTalk

(External HD Only)

(SCSI Printing Only)

Thinnet Ethernet
10Base-T Ethernet

(For Maintenance Only)
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Non-SCSI Connections

Follow this procedure if you are connecting the printer to your 
computer using LocalTalk, Ethernet, or the parallel port. If you 
require a SCSI connection, see “SCSI Connections” on Page 13.

In addition to the items that shipped with your ColorScript 310/
330 printer, you will need:

◆ An adequate length of printer or network cable that matches 
the connection port on the ColorScript 310/330 printer and 
the port on your computer. Refer to your computer 
documentation or system administrator if you are not sure 
which type of cable you need.

To connect your ColorScript 310/330 printer to your computer 
or network:

1. Verify that your printer and computer are both turned 
off.

2. Plug your printer or network cable into the matching 
receptacle on the back of your printer.

See Figure 1-7 for help with matching cables to their printer 
receptacles.

3. Plug the other end of the cable into your computer or 
network.

• Ethernet connectors may be in a wall receptacle or on the 
back of your computer.

• LocalTalk connectors may be in a wall receptacle or on the 
back of your computer, marked with a  symbol. 

If your computer is on a LocalTalk network, your 
computer’s printer port will already be in use by the 
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LocalTalk network wiring. You can still attach your 
ColorScript 310/330 printer to your computer and your 
LocalTalk network; consult your computer’s 
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documentation or your system administrator for the 
recommended configuration.

• Parallel port connectors are on the back of your computer, 
marked with a  symbol or by the words PARALLEL or 
PRINTER.

• ASCSI printer connection requires that you be familiar 
with SCSI terminology and technology, as well as the 
ColorScript-specific steps described in “SCSI 
Connections.”

4. Go to “Switching the Printer On” on Page 18.

SCSI Connections

Some applications, such as Adobe Photoshop, support SCSI 
printing through special Raster mode SCSI printer drivers. 
When using the SCSI printer driver, you can speed up printing 
from Raster (bitmap) applications like Adobe Photoshop by 
printing via a SCSI connection. Use the standard Macintosh 
SCSI driver for SCSI printing from a Macintosh computer. Use 
an ASPI-compatible SCSI driver for SCSI printing from an 
IBM-compatible PC.

NOTE: The SCSI printer connection procedure requires familiarity 
with SCSI terminology and technology, as well as the ColorScript-
specific steps described in this section. Please read through all of this 
section before you connect your printer to your computer using a 
SCSI interface. 
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WARNING: The large 50-pin SCSI port is used exclusively for 
connecting dedicated external hard disks to your printer. Your 
computer cannot communicate with devices connected to this SCSI 
port. Do not connect your computer to the large 50-pin SCSI 
connector.

In addition to the items that shipped with your ColorScript 310/
330 printer, you will need:

◆ An adequate length of SCSI cable that matches the 50-pin 
high-density SCSI port on the ColorScript 310/330 printer 
and the SCSI port on your computer. Refer to your computer 
documentation or SCSI adapter documentation if you are not 
sure which type of cable you need.

To connect your ColorScript 310/330 printer to your computer 
using a SCSI connection:

1. Fill in Table 1-2 to identify SCSI IDs of all SCSI devices 
attached to your computer. 

Each SCSI device attached to your computer must have a 
unique SCSI ID. Potentially valid SCSI IDs are 1, 2, 3, 4, 5, 
and 6. SCSI ID 5 is the default SCSI address for the 
ColorScript 310/330 printer’s SCSI input port. To identify 
which SCSI addresses are in use on your computer, look for 
a small numbered dial or switch on the back or side of all 
devices attached to your computer’s SCSI port. Record the 
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connected devices in the Device Assignment column in 
Table 1-2. 

NOTE: Macintosh users can also use one of several software 
utilities to help identify available SCSI addresses. PC Exchange is 
one such utility that is available with Macintosh Operating System 
7.5 or higher. Other utilities are available, such as SCSI Probe or 
LaCie’s Silverlining.

NOTE: IBM-compatible PC users can use utility software that is 
provided with your SCSI adapter to identify the SCSI addresses used 
in your computer. Your computer documentation or your SCSI 
adapter documentation will have details about any included utility 
software.

Table 1-2  SCSI Address Worksheet for SCSI Printing

SCSI 
ID Device Assignment Notes

0 Computer’s Internal SCSI 
Hard Disk

DO NOT USE THIS SCSI ADDRESS

1 Available unless used by another device

2 Available unless used by another device

3 May be used by CD-ROM drive on 
Macintosh

4 Available unless used by another device

5 Default ColorScript 310/330 Printer 
SCSI ID

6 Available unless used by another device

7 Computer’s CPU or SCSI 
Adapter

DO NOT USE THIS SCSI ADDRESS



Chapter 1 — Installing Your Printer

16

2. Verify that each SCSI device attached to your computer 
has a unique SCSI ID.

Each device you recorded in Table 1-2 must have a unique 
SCSI ID (including the ColorScript 310/330 printer’s SCSI 
input port). 

3. If you need to change the printer’s SCSI input port ID, 
see “Changing the SCSI ID of the Printer’s SCSI Input 
Port” on Page 141. 

It may be easier to change the SCSI ID of other SCSI 
devices attached to your computer than to change the SCSI 
ID of the printer’s SCSI input port. 

4. Verify that your computer, printer, and any other 
connected SCSI devices are turned off.

5. Plug the 50-pin HD-SCSI connector end of the SCSI 
cable into the 50-pin HD-SCSI receptacle on the back of 
the ColorScript 310/330 printer shown in 
Figure 1-8.

WARNING: Do not use the large, 50-pin Centronics-type SCSI 
connector for SCSI printing. Use only the 50-pin HD-SCSI port 
shown in Figure 1-8.

Figure 1-8  Connecting the 50-pin HD-SCSI Cable to the SCSI Printing Port

50-pin HD-SCSI50-pin SCSI 
(External Hard Disk Only) (SCSI Printing Only)
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6. Plug the other end of the SCSI cable into the SCSI port 
on the back of your computer, or into the last SCSI 
device previously connected to your computer.

Secure all cable connections properly using the screws or clips 
on the connectors. 

NOTE: If there are other SCSI devices attached to your computer’s 
SCSI port, connect the ColorScript 310/330 printer to the last SCSI 
device on the SCSI chain. The ColorScript 310/330 printer’s SCSI 
printer port is internally terminated, so it must always be the last 
device on the SCSI chain.

NOTE: The SCSI port on Macintosh computers is marked with a 
 symbol.

NOTE: The SCSI port on most PCs is on an add-on card. It may be 
marked with the acronym SCSI.

7. Switch on the ColorScript 310/330 printer, all other 
SCSI devices, then switch on your computer.

Changing to Raster Mode

Applications that have SCSI printer drivers are typically raster 
(bitmap) applications like Adobe Photoshop. SCSI printer 
drivers print in Raster mode, not PostScript mode, so you need 
to change the printer mode from PostScript to Raster before you 
print to the ColorScript 310/330 printer using a SCSI 
connection. To change to Raster mode:

1. Press the Menu button on the ColorScript 310/330 
printer’s front panel repeatedly until MODE displays in 
the LCD.
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2. Press the Select button to toggle between PS for 
PostScript mode and RAST for Raster mode.

3. Once you’ve selected Raster mode, wait for the LCD to 
return to Ready.

If you print from an application that does not have a Raster 
mode SCSI driver, you will need to switch the ColorScript 310/
330 printer back to PostScript mode. To switch back to 
PostScript mode:

1. Press the Menu button repeatedly on the ColorScript 
310/330 printer’s front panel until MODE displays in 
the LCD.

2. Press the Select button to toggle between PS for 
PostScript mode and RAST for Raster mode.

3. Once you’ve selected PostScript mode, wait for the LCD 
to return to Ready.

Switching the Printer On

WARNING: Make sure that you have removed all packing 
materials from inside and around the printer. Open the printer cover 
and the paper tray cover to verify that all packing materials are 
removed.Refer to Chapter 2, “Loading Paper and Film” for detailed 
instructions on opening the paper cassette.

1. Press the “|” end of the power switch to switch the 
printer on.

The printer’s power switch is located on the lower left 
corner on the front of the printer, and is marked “|” for ON 
and “°” for OFF.
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2. Verify that the printer completes the following start-up 
sequence:

• You hear the cooling fan, hard disk, and paper feed start 
up.

• All front panel lights and the LCD window illuminate.

• The LCD displays a series of start-up messages.

• When the start-up sequence finishes, the LCD reads: 
READY [MEDIA SIZE] [RIBBON TYPE] 
[INTERPRETER TYPE}

Media sizes include A5, A4, A, and Super A for the 
ColorScript 310 printer, and A4, A3, A, Super A, B, and 
Super B for the ColorScript 330 printer. Ribbon types 
can be Monochrome, CMY (Cyan, Magenta, Yellow), 
or CMYK (Cyan, Magenta, Yellow, Black). The 
interpreter type is either raster (RAST) OR PostScript 
(PS).
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• All red status indicators turn off.

If the Ribbon Out icon remains lit, and Replace Ribbon 
displays in the LCD, follow the ribbon loading 
instructions in Chapter 3, “Changing Printer Ribbons.”

If the Paper Out icon remains lit, and Replace Paper 
displays in the LCD, follow the paper loading instructions 
in Chapter 2, “Loading Paper and Film.”

•The green Ready icon remains lit.



Switching the Printer On

21

This page is intentionally left blank.



Chapter 1 — Installing Your Printer

22



21

2
Loading Paper and Film

The ColorScript 310/330 printer prints 24-bit color to dye 
sublimation paper and to transparency film. The ColorScript 
310 printer prints to various paper or specialized transparency 
film sizes, including A5, A4, A, and Super A. The ColorScript 
330 prints to various paper or transparency film sizes, including 
A4, A3, A, Super A, B, and Super B.

This chapter describes how to load dye sublimation paper and 
transparency film into the paper cassette, and how to get the 
paper cassette into and out of the ColorScript 310/330 printer. 
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Loading a Stack of Paper or Film
The paper cassette will hold up to 50 sheets of dye sublimation 
transfer paper or transparency film. To load paper or film:

1. Remove the paper cassette from the front of the printer 
by lifting the cassette slightly and pulling it toward you. 

Set the paper cassette on a flat surface.

Figure 2-1  Removing the Paper Cassette

2. Remove the paper cassette cover and set it aside.

Paper Cassette
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Figure 2-2  Paper Cassette Parts

3. Press downward on the metal lift plate until it locks into 
place on the bottom of the paper tray.

If you are changing media from paper to transparency film 
or vice versa, remove any remaining paper or transparency 
film from the tray.

If you are not changing media size, go to Step 8 on Page 25. 

Figure 2-3  Pressing the Paper Lift Down
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4. If you are changing media size, rotate the metal side rail 
locks away from you so that the side rails can slide 
freely.

This allows you to reposition the side rails to accommodate 
a different size paper or transparency film. 

Figure 2-4  Rotating the Side Rail Locks

5. Adjust the side rails to accommodate the new media.

The side rails have a geared action; move them by pressing 
together or spreading apart at the center of each rail. Make 
sure the media size indicators on the end of the side rails 
align with the notches on the bottom of the paper tray.

Figure 2-5  Adjusting the Side Rails

Rotate Side Rail 

Side Rails

Paper Tray

Locks Away from You
Rotate Side Rail 
Locks Away from You

Side Rails

Paper Tray

Adjust Side Rails 

End Stop

Adjust Side Rails 
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6. Rotate the metal side rail locks back into place.

7. Position the end stop to accommodate the new media.

Squeeze the sides of the end stop and slide it to the position 
marked for the media size you are loading. The end stop 
locks into place.

8. Gently fan the stack of paper or film, and neatly stack 
the paper shiny-side (print-side) down.

NOTE:  Dye sublimation transfer paper has a shiny surface on the 
print side, and a satin finish on the back. The paper must be inserted 
shiny-side down. Avoid touching the print-side of paper or film with 
your fingers; fingerprint oil can affect print quality. 

9. Position the stack so that the front edge is over the metal 
lift plate, beneath the two metal flanges.

The media should settle neatly into the bottom of the paper 
tray between the side rails.

Figure 2-6  Placing the Media into the Paper Tray

Insert Media Under Media Settles Between 
Side RailsMetal Flanges
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10. Insert a finger through the opening in the bottom of the 
paper tray and push the metal lift plate up against the 
paper or film.

The plate is spring-loaded to press the paper or film up 
against the two metal flanges.

Figure 2-7  Pushing the Lift Plate Back into Position

11. Set the paper cassette cover on the paper tray so that the 
cover is fully seated on the paper tray.

12. Set the media detect switch to match the media type in 
the paper cassette.

The green plastic media detect switch in the right rear of the 
paper cassette indicates to the printer whether paper or 
transparency film is in the paper tray. Move the switch 
toward the front of the paper tray for transparency film, or 
toward the rear of the paper tray for paper.

Insert Finger through Hole Under Tray
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Figure 2-8  Setting the Media Detect Switch

13. Adjust the paper stop on the paper tray cover so that its 
embossed arrow matches the size of the paper in the 
cassette.

Figure 2-9  Adjusting the Paper Stop

14. Slide the paper cassette gently into the printer until it 
stops.

Using the Manual Feed Tray
You can feed paper or film manually into the ColorScript 310/
330 printer.

Paper or transparency film in the manual feed tray has priority 
over media in the cassette, so you can print to a different size or 
type of media without reloading the paper cassette. 

Media Detect Switch

Transparency Film

Paper

Adjust Paper Stop to Fit Paper Size
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To print from the manual feed tray:

1. Move the paper guides on top of the paper cassette to 
match the size of the media you want to feed manually.

Line up the size marks near the left guide.

2. Pull the paper stop all the way toward you.

3. Insert a sheet of paper or transparency film print-side 
down. 

Feed the media carefully under the metal guides and 
through the slots in the paper guides. 

Figure 2-10  Using the Manual Feed Tray

4. Push the media into the printer until it stops. The media 
will automatically be loaded into the printer.

The ColorScript 310/330 printer will automatically select 
the paper in the manual feed tray if you load paper into the 
manual feed tray before printing to the ColorScript 310/330 
printer.

Metal Guide

Paper Stop

Paper Feed Door—Lift Open
for Small Paper Sizes
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3
Changing Printer Ribbons

The printer ribbon is a roll of dye-coated mylar that rests in a 
plastic ribbon cassette. Three types of ribbons are available: 

◆ Cyan, magenta, yellow (CMY) 

◆ Cyan, magenta, yellow, black (CMYK)

◆ Monochrome (Continuous black)

The multicolored ribbons contain sets of individual bands of 
dye that print in successive passes; yellow prints first, then 
magenta, then cyan. If you are using four-color ribbon, the black 
band prints last. 

Monochrome ribbon is one continuous band of black dye, so 
monochrome output prints in one pass. Consequently, printing 
your drafts in monochrome mode saves time when printing.
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Upon startup, and every time you close the printer cover, the 
ColorScript 310/330 printer winds the printer ribbon to the start 
of the next color set. When using monochrome ribbon, which is 
one continuous band of black dye, you will need to disable the 
ribbon advance feature by manually setting the printer to 
monochrome mode before you close the printer cover. See 
“Printing in Monochrome Mode” on Page 35.

NOTE: If you often switch from one ribbon type to another, 
consider purchasing extra ribbon cassettes so you can quickly change 
ribbons without removing them from their cassettes.

Removing the Ribbon Cassette

WARNING: If this is the printer’s first dye ribbon installation, 
make sure that you remove all packing materials from inside the 
printer. See “Unpacking the Printer” on Page 2 for complete 
unpacking instructions.

To remove a spent ribbon, or to install the printer’s first ribbon:

1. Open the top cover of the printer by pulling the recessed 
locking switch toward the front of the printer. 

The cover will pop up slightly. Gently lift the cover until it 
stops.
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Figure 3-1  Opening the Printer Cover

WARNING: The cover will stop when raised about 75° above 
horizontal. Do not force the cover open wider than 75° above 
horizontal. 

WARNING: The thermal print head reaches 400° F during 
operation. Take care not to touch the print head if the printer has been 
operating.

2. Using both hands, place your thumbs in the handles on 
each side of the ribbon cassette. 

The dye ribbon rides in a plastic cassette, embossed with L 
and R on the top edge, indicating the left and right sides, 
respectively.

3. Gently lift the front of the ribbon cassette up, then pull 
the entire cassette up and toward you. 

Printer Cover Switch
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Figure 3-2  Lifting the Ribbon Cassette Up and Toward You

NOTE: The supply spindle is toward the rear of the cassette. When 
the ribbon is completely used, it is wound entirely onto the front 
spindle.

4. Place the ribbon cassette on a flat surface.

If you are installing the printer’s first ribbon, there will be 
no ribbon in the ribbon cassette. Go to “Installing a New 
Ribbon” on Page 32.

5. Remove the spent ribbon.

Installing a New Ribbon
1. Once you have removed the spent ribbon, place the new 

ribbon in the ribbon cassette. 

The full spindle must go to the cassette’s rear bay, while the 
empty spindle rests in the forward bay. Take care to touch 
the ribbon only on the outside (uncoated) surface.

Cassette Handle

Ribbon Cassette

Thermal Print Head

Printer Cover



Installing a New Ribbon

33

Figure 3-3  Installing a New Dye Ribbon

NOTE: The dye ribbon must exit each spindle over the top. The 
dye-coated side of the ribbon faces down, where it can contact the 
paper below the ribbon cassette. The plastic gears at the spindle ends 
must be on the right side of the ribbon cassette, indicated by an R on 
the cassette.

2. Holding the ribbon cassette by the handles, lower it 
gently into the printer. 

Verify that the gears engage and both spindles settle fully 
into place.

3. Rotate the green ribbon winding wheel at the upper 
right of the printer opening (see Figure 3-4). 

Facing the front of the printer, turn the wheel toward you to 
take up the slack in the dye ribbon. 

Ribbon Cassette

Full Spindle in Back

Gears

Empty Spindle in Front
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NOTE: The paper may jam if the dye ribbon is too slack, but do not 
overtighten the ribbon. The ribbon should drape smoothly between 
the two rollers, sagging no more than 1 inch (2.5 cm) below 
horizontal.

Figure 3-4  Winding the Ribbon Wheel

NOTE: If you are installing a continuous monochrome ribbon, skip 
the rest of this procedure and follow the instructions in “Printing in 
Monochrome Mode” on Page 35.

4. Press downward gently on the printer cover until it 
clicks into place.

The red front panel indicators should all turn off. 

You will hear a whirring sound as the printer moves the dye 
ribbon forward to the first dye panel.

If the front panel ribbon indicator glows red, open the top 
cover and review this procedure. Be sure that the dye ribbon 
and all gears are properly seated.

Ribbon Wheel

Front Spindle

Cassette HandleRear
Spindle
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Printing in Monochrome Mode
You can conserve dye ribbon by printing your drafts in 
grayscale from a monochrome ribbon. If you install a 
monochrome dye ribbon, you need to manually set the 
ColorScript 310/330 printer to print in monochrome mode. 

To set the ColorScript 310/330 printer to print in 
monochrome mode:

1. Follow Steps 1 through 3 on Pages 30 through 31, but do 
not close the printer cover.

2. With the printer cover open, press the Menu button on 
the printer’s front panel until MONOCHROME 
appears in the LCD.

3. Press the Select button to display ON in the LCD.

4. Once the Monochrome mode is selected, wait for the 
LCD to return to Ready.

The ColorScript 310/330 printer accepts the input that is 
selected when it returns to Ready.

To switch back to color mode:

1. Follow Steps 1 through 3 on Pages 30 through 31. Do not 
close the printer cover.

Replace the monochrome ribbon with a multicolored 
ribbon.

2. With the printer cover open, press the Menu button 
until MONOCHROME appears in the LCD.

3. Press the Select button to display OFF.

4. Wait for the LCD to return to Ready.

The ColorScript 310/330 printer accepts the input that is 
selected when it returns to Ready.
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4
Printing from the Mac OS

Printing to the ColorScript 310/330 printer follows the same 
procedures as printing to any other PostScript-compatible 
printer connected to your computer. You can print to the 
ColorScript 310/330 printer over a network or by direct 
connection to your printer port. If you have a SCSI printer 
driver, you can also print to the ColorScript 310/330 printer 
using a SCSI connection. To connect your ColorScript printer to 
your computer, refer to Chapter 1, “Installing Your Printer.”

Installing the Printing Software
The only software you need to print to your ColorScript 310/
330 printer is the PostScript Printer Description (PPD) file that 
is on the Macintosh ColorScript 310/330 Printer 
Descriptions diskette. 
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The PPD enables your computer to communicate with the 
ColorScript printer. To install the ColorScript PPD:

1. Insert the Macintosh ColorScript 310/330 Printer 
Descriptions diskette into your diskette drive.

2. Copy the SECS2DP1.PPD or SECS2DP2.PPD file 
into the Printer Descriptions folder inside your 
Extensions folder, located in your System Folder. 

Copy the SECS2DP1.PPD file if you have a ColorScript 
310 printer, and copy the SECS2DP2.PPD file if you have 
a ColorScript 330 printer.

3. Restart your computer.

Follow the procedure in “Configuring the Printer” to set up 
the ColorScript 310/330 printer.

Configuring the Printer
Make sure that the ColorScript 310/330 printer is turned on and 
connected to your network or to your computer. If you need to 
connect your ColorScript printer to your computer, refer to 
Chapter 1, “Installing Your Printer.”

Selecting the Printer

In a typical Macintosh Operating System environment, the 
primary printer will be a monochrome LaserWriter or inkjet 
printer, and an advanced printer like the ColorScript 310/330 
printer will be used only for color pre-press proofs. You can 
switch between your connected printers by selecting the desired 
printer from the Chooser. To select the ColorScript 310/330 
printer:
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1. Select the Chooser from the Apple Menu.

You will see a Chooser window similar to the one shown in 
Figure 4-1. 

Figure 4-1  Chooser Window 

NOTE:  The names and icons in your Chooser may be 
different from those shown here. Also, if your network does not 
include zones, or if your computer is not on an AppleTalk network, 
you will not see an AppleTalk Zones field. 

2. Select your LaserWriter printer driver from the choices 
displayed in the upper left corner of the Chooser 
window. 

At the time of this manual’s printing, LaserWriter 8 is the 
recommended printer driver for the ColorScript 310/330 
printer. If the LaserWriter 8 driver is not available in your 
Chooser, reinstall your Macintosh printing software from 
your installation diskettes or CD-ROM.
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3. In the AppleTalk Zones field, select the network zone 
that contains the ColorScript 310/330 printer.

The names of all the printers in a selected zone appear in the 
Select a PostScript Printer field. If there are no zones on 
your network, or if your computer is not on an AppleTalk 
network, you will not see an AppleTalk Zones field, and the 
names of all connected printers will appear in the Select a 
PostScript Printer field when you select your LaserWriter 
printer driver. 

4. Select the ColorScript 310/330 printer.

If there is a color printer icon to the left of the ColorScript 
310/330 printer name, your printer is already properly set 
up and you can print to the selected ColorScript 310/330 
printer. See “Printing from Various Applications” on 
Page 45.

If a printer icon does not display next to the ColorScript 
310/330 printer name, follow the set-up procedure in the 
following section.

NOTE: If you need to print to another printer on your network, 
select the desired printer from the Chooser.

Setting up the Printer

Before you can print to a printer, you must set up the printer. 
Setting up the printer verifies that your computer can 
communicate properly with the ColorScript 310/330 printer 
using the PPD you installed in the procedure on Page 37. To set 
up the printer:
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1. After you’ve selected your printer and determined that 
you need to set up the ColorScript 310/330 printer, click 
on the Setup button in the Chooser.

The Setup window similar to the one shown in Figure 4-2 
displays.

Figure 4-2  Setup Window before ColorScript Printer Setup

NOTE: If your Setup window displays the correct ColorScript PPD 
as shown in Figure 4-4, you do not need to set up the printer again. 
Just click on the OK button and you may use the selected ColorScript 
310/330 printer.

2. Click on the Auto Setup button.

Your computer opens a connection to the printer and 
automatically detects what kind of a printer is connected. 
During the detection process, the Setup Status window 
shown in Figure 4-3 displays.
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Figure 4-3  Setup Status Window

After several seconds, the Setup Status window closes and 
the name of the PPD file you installed in the procedure on 
Page 37 will appear under the Current Printer Description 
File (PPD) Selected line in the Setup Window, as shown in 
Figure 4-4.

Figure 4-4  Setup Window after ColorScript Printer Setup

If your computer is unable to automatically set up the printer, 
the Select a PostScript Printer Description File window similar 
to the one shown in Figure 4-5 displays, and you will need to 
manually select the correct PPD file for your ColorScript 310/
330 printer. To manually set up your ColorScript 310/330 
printer:

1. If the Select a PostScript Printer Description File 
window shown in Figure 4-5 displays, select the PPD file 
that you installed in the procedure on Page 37 from the 
list of available PPD files. 
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Choose the SECS2DP1.PPD if you have a ColorScript 310 
printer, or the SECS2DP2.PPD if you have a ColorScript 
330 printer.

Figure 4-5  Select PostScript Printer Description File Window

2. Click on the Select button.

The Setup Status window shown in Figure 4-3 displays for 
several seconds. Then the Setup Status window closes and 
the name of the installed PPD file appears under the Current 
Printer Description File (PPD) Selected line in the Setup 
Window, as shown in Figure 4-4.

NOTE: If you want to print to the ColorScript 310/330 from other 
computers on your network, you will have to complete the 
installation and set-up process at those computers also.
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Calibrating Color
The final step in configuring your ColorScript 310/330 printer is 
calibrating the color. Your printer includes Agfa™ FotoTune™ 
software that synchronizes the colors that print on the 
ColorScript 310/330 printer with common printing standards. 
Refer to the color calibration software manual included with 
your Agfa FotoTune software for complete color calibration 
instructions.

QMS Europe B.V. will distribute updated color calibration files 
to keep your ColorScript 310/330 printer up-to-date with new 
hardware and software.
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Printing from Various Applications
Printing to the ColorScript 310/330 printer is essentially the 
same process as printing to other PostScript printers. However, 
some aspects of the Print, Print Setup, or other windows may 
need special attention when printing to the ColorScript 310/330 
printer. 

The following pages describe the special configuration issues 
involved in printing to the ColorScript 310/330 printer from five 
common graphics and page layout programs:

◆ Adobe Illustrator 5.5 on Page 46

◆ Adobe PageMaker 6.0 on Page 50

◆ Adobe Photoshop 3.0.5 on Page 57

◆ Macromedia Freehand 5.5 on Page 60

◆ Quark Express 3.3 on Page 66

Prior to printing from these or any other Macintosh applications, 
you will need to verify the settings for parameters such as media 
size, image orientation, separations, and numerous other 
customizable printing options. The following sections describe 
the important settings to check and adjust as necessary before 
you print from each of the five documented applications.
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Adobe Illustrator 5.5

Before printing to the ColorScript 310/330 printer from Adobe 
Illustrator 5.5, select the ColorScript 310/330 printer from the 
Chooser (see Page 38 for instructions).

To print to the ColorScript 310/330 printer from Adobe 
Illustrator 5.5:

1. Choose Page Setup from the File menu.

The Page Setup Window displays, similar to the one shown 
in Figure 4-6.

Figure 4-6  Adobe Illustrator 5.5 Page Setup Window

2. Verify that the Page Setup variables match your 
intended output characteristics.

Change any of the Page Setup variables to suit your needs:

• Paper size

• Layout

• Reduction or enlargement

• Page orientation

3. When all variables match your output requirements, 
click OK to close the Page Setup window.
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NOTE: Customized settings in the Document Setup, Print, and 
Print Options windows can override settings in the Page Setup 
window. The Page Setup settings are the default settings for a new 
print job. Any changes you make in the Print or Print Options 
windows will only affect the current print job.

4. Choose Document Setup from the File menu.

The Document Setup window displays, similar to the one 
shown in Figure 4-7.

Figure 4-7  Adobe Illustrator 5.5 Document Setup Window
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5. Verify that the Document Setup variables match your 
intended output characteristics.

Change any of the Document Setup variables to suit your 
needs:

• Paper size

• Image dimensions

• Layout

• Page orientation

• Output resolution

• Complex path treatment

NOTE: Check the Use Page Setup checkbox to revert to the Page 
Setup settings instead of using the Document Setup settings.

6. When all variables match your output requirements, 
click OK to close the Document Setup window.

7. Choose Print from the File menu.

The Print window displays, similar to the one shown in 
Figure 4-8.

Figure 4-8  Adobe Illustrator 5.5 Print Window
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8. Click on the Print Options button on the right side of the 
Print window to change the settings shown in Figure 4-
22:

• Cover page usage

• Color or Grayscale printing

• PostScript error notification

Figure 4-9  Adobe Illustrator 5.5 Print Options Window

9. When all the settings are correct, click OK to close the 
Print Options window.

10. When you have set all options to match your desired 
output, click on the Print button in the Print window.
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Adobe PageMaker 6.0

Before printing to the ColorScript 310/330 printer from Adobe 
PageMaker 6.0, select the ColorScript 310/330 printer from the 
Chooser (see Page 38 for instructions).

To print to the ColorScript 310/330 printer from Adobe 
PageMaker 6.0:

1. Choose Document Setup from the File menu.

The Document Setup window displays, similar to the one 
shown in Figure 4-10.

Figure 4-10  Adobe PageMaker 6.0 Document Setup Window
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2. Verify that the Document Setup variables match your 
intended output characteristics.

Change any of the Document Setup variables to suit your 
needs:

• Paper size

• Image dimensions

• Page orientation

• Margins

• Layout

• Number of pages

• Output resolution

3. When all variables match your output requirements, 
click OK to close the Document Setup window.
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4. Choose Print from the File menu.

The Print Document window displays, similar to the one 
shown in Figure 4-11.

Figure 4-11  Adobe PageMaker 6.0 Print Document Window

5. Verify that the settings in the Print Document window 
match your intended output:

• Printer PostScript description

• Number of copies and pages

• Copy handling properties

• Page orientation
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6. Click on the Paper button to continue reviewing the 
document’s settings.

The Print Paper window displays, similar to the one shown 
in 
Figure 4-12.

Figure 4-12  Adobe PageMaker 6.0 Print Paper Window

7. Verify that the settings in the Print Paper window match 
your intended output:

• Paper size

• Paper source

• Paper handling

• Tiling

• Reduction, enlargement, or thumbnail usage
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8. Click on the Options button to continue reviewing the 
document’s settings.

The Print Options window displays, similar to the one 
shown in Figure 4-13.

Figure 4-13  Adobe PageMaker 6.0 Print Options Window

9. Verify that the settings in the Print Options window 
match your intended output:

• TIFF and image handling

• PostScript handling

• Printer communication
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10. Click on the Color button to continue reviewing the 
document’s settings.

The Print Color window displays, similar to the one shown 
in 
Figure 4-14.

Figure 4-14  Adobe PageMaker 6.0 Print Color Window

11. Verify that the settings in the Print Color window match 
your intended output:

• Composite or Separations handling

• Screen optimization

• CMS setup
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12. When you have adjusted all settings to match your 
output requirements, click on the Print button.

You can print from the Print Document, Print Paper, Print 
Options, or the Print Color windows.
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Adobe Photoshop 3.0.5

Before printing to the ColorScript 310/330 printer from Adobe 
Photoshop 3.0.5, select the ColorScript 310/330 printer from the 
Chooser (see Page 38 for instructions).

To print to the ColorScript 310/330 printer from Adobe 
Photoshop 3.0.5:

1. Choose Page Setup from the File menu.

The Page Setup Window displays, similar to the one shown 
in Figure 4-15.

Figure 4-15  Adobe Photoshop 3.0.5 Page Setup Window

2. Verify that the Page Setup variables match your 
intended output characteristics.

Change any of the Page Setup variables to suit your needs:

• Paper size

• Layout

• Reduction or enlargement
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• Page orientation

• Screen, transfer, Background, border, and bleed settings

• Calibration, registration, and crop marks

3. When all variables match your output requirements, 
click OK to close the Page Setup window.

NOTE: Customized settings in the Print and Print Options 
windows can override settings in the Page Setup window. The Page 
Setup settings are the default settings for a new print job. Any 
changes you make in the Print or Print Options windows will affect 
only the current print job.

4. Choose Print from the File menu.

The Print window displays, similar to the one shown in 
Figure 4-16.

Figure 4-16  Adobe Photoshop 3.0.5 Print Window
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5. Click on the radio button (at the lower left of the Print 
window) that matches the installed ribbon type.

You can print in Grayscale, RGB (CMY), or CMYK modes.

6. Choose ASCII or Binary encoding using the radio 
buttons at the lower right of the Print Window.

Use binary encoding for most situations. Use ASCII only 
for interfaces that do not support binary encoding. 

7. Click on the Print Options button on the right side of the 
Print window to change the settings shown in Figure 4-
17:

• Cover page usage

• Color or Grayscale printing

• PostScript error notification

Figure 4-17  Adobe Photoshop 3.0.5 Print Options Window

8. When all variables match your output requirements, 
click OK to close the Print Options window.

9. When you have set all settings to match your output 
requirements, click on the Print button in the Print 
window.
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Macromedia Freehand 5.5

Before printing to the ColorScript 310/330 printer from 
Macromedia Freehand 5.5, select the ColorScript 310/330 
printer from the Chooser (see Page 38 for instructions).

To print to the ColorScript 310/330 printer from Macromedia 
Freehand 5.5:

1. Choose Page Setup from the File menu.

The Page Setup Window displays, similar to the one shown 
in Figure 4-18.

Figure 4-18  Macromedia Freehand 5.5 Page Setup Window

2. Verify that the Page Setup variables match your 
intended output.

Change any of the Page Setup variables to suit your needs:

• Paper size

• Layout

• Reduction or enlargement

• Page orientation
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3. When all variables are correct, click OK to close the 
Page Setup window.

NOTE: Customized settings in the Print and Print Options 
windows can override settings in the Page Setup window. The Page 
Setup settings are the default settings for a new print job. Any 
changes you make in the Print or Print Options windows will affect 
only the current print job.

4. Choose Print from the File menu.

The Print window displays, similar to the one shown in 
Figure 4-19.

Figure 4-19  Macromedia Freehand 5.5 Print Window
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5. Verify that the parameters listed at the bottom of the 
Print window match your intended output 
characteristics.

If you need to adjust any of the parameters listed, continue 
this procedure. 

If the parameters shown in the Print window all match your 
output requirements, skip to Step 12 on Page 65.

6. Click on the Options button in the upper right of the 
Print window to change the settings shown in Figure 4-
20:

• Cover page usage

• Color or Grayscale printing

• PostScript error notification

Figure 4-20  Macromedia Freehand 5.5 Print Options Window for General 
Settings

7. When all the settings are correct, click OK to close the 
Print Options window.

8. Click on the Output button in the lower left of the Print 
window to change the settings shown in Figure 4-21:
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• RGB TIFF to CMYK conversion

• Maximum color steps

• Flatness

• Inclusion or exclusion of invisible layers

• Complex path treatment 

• Data encoding (Binary mode recommended)

Figure 4-21  Macromedia Freehand 5.5 Output Options Window

9. When all the settings are correct, click OK to close the 
Output Options window.
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10. Click on the Print button in the lower left of the Print 
window to change the settings shown in Figure 4-22:

• Printer type

• Paper size

• Halftone and screen resolutions

• Page orientation

• Transfer mode

• Printer marks

• Page labels

• Imaging options

Figure 4-22  Macromedia Freehand 5.5 Print Options Window for Freehand-
specific Settings
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11. When all the settings are correct, click OK to close the 
Print Options window.

12. When you have set all options to match your output 
requirements, click on the Print button in the Print 
window.
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Quark Express 3.3

Before printing to the ColorScript 310/330 printer from Quark 
Express 3.3, select the ColorScript 310/330 printer from the 
Chooser (see Page 38 for instructions).

To print to the ColorScript 310/330 printer from Quark 
Express 3.3:

1. Choose Page Setup from the File menu.

The Page Setup Window displays, similar to the one shown 
in Figure 4-23.

Figure 4-23  Quark Express 3.3 Page Setup Window
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2. Verify that the Page Setup variables match your 
intended output.

Change any of the Page Setup variables to suit your needs:

• Paper size

• Layout

• Reduction or enlargement

• Page orientation

• Printer type

• EfiColor Profile

• Resolution

• Data format (Binary recommended)

• Halftone screen

3. When all variables match your output requirements, 
click OK to close the Page Setup window.

NOTE: Customized settings in the Document Setup, Print, and 
Print Options windows can override settings in the Page Setup 
window. The Page Setup settings are the default settings for a new 
print job. Any changes you make in the Print or Print Options 
windows will affect only the current print job.
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1. Choose Document Setup from the File menu.

The Document Setup window displays, similar to the one 
shown in Figure 4-24.

Figure 4-24  Quark Express 3.3 Document Setup Window

2. Verify that the Document Setup variables match your 
intended output characteristics.

Change any of the Document Setup variables to suit your 
needs:

• Paper size

• Facing page handling

3. When all variables match your output requirements, 
click OK to close the Document Setup window.
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4. Choose Print from the File menu.

The Print window displays, similar to the one shown in 
Figure 4-25.

Figure 4-25  Quark Express 3.3 Print Window

5. Verify that the Print window variables match your 
intended output characteristics.

Change any of the Print window variables to suit your 
needs:

• Number of copies

• Page range

• Paper handling

• Tiling
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• Separations

• Registration marks

6. Click on the Print Options button on the right side of the 
Print window to change the settings shown in Figure 4-
26:

• Cover page usage

• Color or Grayscale printing

• PostScript error notification

Figure 4-26  Quark Express 3.3 Print Options Window

7. When all variables match your output requirements, 
click OK to close the Print Options window.

8. When you have set all settings to match your output 
requirements, click on the Print button in the Print 
window.
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Reprinting the Last Printed Page
You can press the Reprint button on the printer’s front panel to 
reprint the last page sent to the ColorScript 310/330 printer. 
This feature is useful for quickly printing several copies of a 
final proof once the output meets your requirements. This saves 
the processing time involved in sending another print job from 
your computer to the printer.

The Reprint function prints only the last page printed, not the 
last print job, and several actions can prevent the printer from 
reprinting the last page:

◆ Turning off the printer

◆ Changing the ribbon type

◆ Changing the paper size

◆ Starting another print job

To reprint the last page printed:

◆ Press the Reprint button on the front panel of the 
ColorScript 310/330 printer.
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5
Printing from Windows

Printing to the ColorScript 310/330 printer follows the same 
procedures as printing to any other PostScript-compatible 
printer connected to your computer. You can print to the 
ColorScript 310/330 printer over a network or by direct 
connection to your printer port. 

Setting Up the Printer
Make sure that the ColorScript 310/330 printer is turned on and 
connected to your network or to your computer. If you need to 
connect your ColorScript printer to your computer, refer to 
Chapter 1, “Installing Your Printer.”

The process of setting up the printer requires that you first 
install the appropriate printer driver from the printer drivers 
diskette included with your ColorScript 310/330 printer. 
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Once you install the correct printer driver, you will configure 
your system so that your computer and printer will 
communicate properly. 

Carefully follow the set-up instructions for your operating 
system.

◆ Windows 3.1 users follow the instructions that begin on this 
page.

◆ Windows 95 users should proceed to “Setting Up the Printer 
in Windows 95” on Page 79.

NOTE: If your printer is connected to your computer by a SCSI 
connection, you do not need to configure the ColorScript 310/330 
printer in Windows 3.1 or Windows 95. Your applications will 
communicate with the printer using specialized, application-specific 
printer drivers. Refer to your SCSI printer driver documentation for 
instructions on configuring SCSI printing software.

Installing Windows 3.1 Printer Software

1. Insert the Windows 3.1 ColorScript 310/330 Drivers 
diskette into your 3.5-inch diskette drive.

2. From the Program Manager, double-click the Control 
Panel Icon in the Main program group.
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3. Double-click the Printers control panel in the Control 
Panel Window.

The Printers window displays, similar to the one shown in 
Figure 5-1.

Figure 5-1  Printers Window
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4. Click the Add button in the Printers window.

The Printers window expands to include a list of available 
printer drivers, as shown in Figure 5-2.

Figure 5-2  Install Printers Window

5. Select Install Unlisted or Updated Printer from this list 
of printers, then click the Install button.

The Install Driver window displays, and you can install 
printer drivers from a diskette.

6. Enter the letter of the drive that contains the Windows 
3.1 ColorScript 310/330 Drivers diskette.

If your 3.5-inch diskette drive is drive A, enter A:. If your 
3.5-inch diskette drive is drive B, enter B:.
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7. Click OK.

The Add Unlisted or Updated Printer window will display 
the names of the ColorScript printer drivers found on the 
Windows 3.1 ColorScript 310/330 Drivers diskette.

8. Select the your ColorScript model name from the list of 
available printer drivers.

9. Click OK.

The name of your ColorScript 310/330 printer displays in 
the Installed Printers list box in the Printers window.

10. Select the ColorScript model you just installed from the 
Installed Printers window, then click Connect.

The Connect window displays.

Figure 5-3  Connect Window
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11. From the Ports list box, select the printer port you want 
to assign to the ColorScript 310/330 printer.

• Parallel port connections: choose an available LPT port 
(LPT 1, LPT2, etc.) 

• Network connections: choose an available LaserWriter 
port (c:\lw1.prn, c:\lw2.prn, etc.)

12. Click OK to close the Connect window.

13. Click Close to close the Printers window.

14. Close the Control Panel window.

Your ColorScript 310/330 printer is now ready to print in 
Windows 3.1.
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Setting Up the Printer in Windows 95

Windows 95 uses a series of prompts called wizards to guide 
you through many set-up processes. You will use the Add 
Printer wizard to gather the information needed to print to your 
ColorScript 310/330 printer in Windows 95. During the set-up 
process, the Add Printer wizard will prompt you for certain 
information:

◆ You will need to know whether your printer model is the 
ColorScript 310 or the ColorScript 330.

◆ You will need to know whether your ColorScript 310/330 
printer is connected to your computer by a local connection or 
a network connection. 

• Use Local connection for parallel port connections. 

For Local connections, see “Setting Up a Local Printer 
Connection” on Page 80.

• Use Network connection if you are connected to the 
ColorScript 310/330 printer over an Ethernet network.

The ColorScript 310/330 printer can be connected to your 
network either by connecting the printer directly to your 
Ethernet network or by connecting the printer to another 
Windows 95 workstation on your Windows 95 network.

For Network connections, see “Setting up a Network 
Printer Connection” on Page 82.

Refer to Chapter 1, “Installing Your Printer,” if you have not 
connected the printer to your computer. 

You will also need to have the Windows 95 ColorScript 310/330 
Drivers diskette available, and your ColorScript 310/330 printer 
must be turned on and warmed up.
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Setting Up a Local Printer Connection

To set up a Windows 95 printer connected by a parallel port 
connection:

1. Insert the Windows 95 ColorScript 310/330 Drivers 
diskette into your 3.5-inch diskette drive.

2. Click the Start button in the Taskbar, point to Settings, 
and click Printers.

Figure 5-4  Using the Start Button to Set up Your Printer



Setting Up the Printer

81

The Printers window displays, similar to the one shown in 
Figure 5-5.

Figure 5-5  Printers Window

3. Double-click Add Printer.

This starts the Add Printer wizard, which is a series of 
dialog boxes that step you through the process of setting up 
your printer properly.

4. Click Next in the Add Printer wizard.

5. Select Local printer and click Next.

If you connected your ColorScript 310/330 printer to your 
computer over an Ethernet network, go to “Setting up a 
Network Printer Connection” on Page 82.

If you connected your ColorScript 310/330 printer to your 
computer using a parallel port connection, continue with 
this procedure. 

6. Click Have Disk.

7. Enter the letter of the drive that contains the Windows 
95 ColorScript 310/330 Drivers diskette.

If your 3.5-inch diskette drive is drive A, enter A:. If your 
3.5-inch diskette drive is drive B, enter B:.
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8. Click OK.

The wizard displays the names of the available ColorScript 
models.

9. Select the your ColorScript model name from the 
Printers list box, then click Next.

10. Select the port that you want to assign to your printer.

Choose an available LPT port (LPT 1, LPT2, etc.). 

11. Click Next.

12. Enter the printer name and click Next.

The Add Printer wizard defaults to the ColorScript model 
name you selected in Step 9. You can accept this name or 
enter another name of your choice.

13. Make sure the ColorScript 310/330 printer is connected 
to your computer, switched on, and warmed up.

Do not connect the printer to your computer when either 
machine is on. Refer to Chapter 1, “Installing Your Printer,” 
for instructions on connecting the printer to your computer.

14. Select Yes to print a test page, then click Next.

Printing the test page verifies that the printer is properly 
connected and installed. If the test page does not print 
successfully, refer to Chapter 8, “Maintaining and 
Troubleshooting Your Printer.”

Setting up a Network Printer Connection

You can connect to the ColorScript 310/330 printer over an 
Ethernet network either by connecting the printer directly to 
your Ethernet network or by connecting the ColorScript 310/
330 printer to another Windows 95 workstation on your 
Windows 95 network. 
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Refer to Chapter 1, “Installing Your Printer,” for instructions on 
connecting the printer to your computer. 

NOTE: You must be connected to a Windows 95 network in order 
to connect to the ColorScript 310/330 printer using a Windows 95 
network connection. Refer to your Windows 95 user documentation 
for instructions on connecting to a Windows 95 network.

To set up a Windows 95 network printer connected by an 
Ethernet connection:

1. Insert the Windows 95 ColorScript 310/330 Drivers 
diskette into your 3.5-inch diskette drive.

2. Click the Start button in the Taskbar, point to Settings, 
and click Printers.

Figure 5-6  Using the Start Button to Set up Your Printer
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The Printers window displays, similar to the one shown in 
Figure 5-7.

Figure 5-7  Printers Window

3. Double-click Add Printer.

This starts the Add Printer wizard, which is a series of 
dialog boxes that step you through the process of setting up 
your printer properly.

4. Click Next in the Add Printer wizard.

5. Select Network printer and click Next.

If you connected your ColorScript 310/330 printer to your 
computer by a parallel or SCSI connection, “Setting Up a 
Local Printer Connection” on Page 80.”

If you connected your ColorScript 310/330 printer to your 
computer over an Ethernet network, continue with this 
procedure.

6. Enter the network path to the ColorScript 310/330 
printer, or click Browse to find the printer on the 
network.

• If the printer is connected directly to your network, the 
printer will appear in the Network Neighborhood. 
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• If the printer is connected directly to another Windows 95 
computer on your network, connect first to the host 
workstation and select the ColorScript 310/330 printer.

7. Click Next.

8. Select Yes or No to indicate whether you will print to the 
ColorScript 310/330 printer from MS-DOS applications.

If you do not need to print to the ColorScript 310/330 
printer from a specific MS-DOS application, select No.

9. Click Next.

10. Click Have Disk.

11. Enter the letter of the drive that contains the Windows 
95 ColorScript 310/330 Drivers diskette.

If your 3.5-inch diskette drive is drive A, enter A:. If your 
3.5-inch diskette drive is drive B, enter B:.

12. Click OK.

The wizard displays the names of the available ColorScript 
models.

13. Select the your ColorScript model name from the 
Printers list box, then click Next.

14. Select the port that you want to assign to your printer.

Choose an available LaserWriter port (LW1, LW2, etc.).

15. Click Next.

16. Enter the printer name and click Next.

The wizard defaults to the ColorScript model name you 
selected in Step 13. You can accept this name or enter 
another name of your choice.
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17. Make sure the ColorScript 310/330 printer is switched 
on and is warmed up.

Do not connect the printer to your computer when either 
machine is on. Refer to Chapter 1, “Installing Your Printer,” 
for instructions on connecting the printer to your computer.

18. Select Yes to print a test page, then click Next.

Printing the test page verifies that the printer is properly 
connected and installed. If the test page does not print 
successfully, refer to Chapter 8, “Maintaining and 
Troubleshooting Your Printer.”
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Calibrating Color
The final step in configuring your ColorScript 310/330 printer is 
calibrating the color. Your printer includes Agfa™ FotoTune™ 
software that synchronizes the colors that print on the 
ColorScript 310/330 printer with known image setters. Refer to 
the color calibration software manual included with your Agfa 
FotoTune software for complete color calibration instructions.

QMS Europe B.V. will distribute updated color calibration files 
to keep your ColorScript 310/330 printer up-to-date with new 
hardware and software.
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Printing from Various Applications
Printing to the ColorScript 310/330 printer is essentially the 
same process as printing to other PostScript printers. However, 
some aspects of the Print or Print Setup windows may need 
special attention when printing to ColorScript 310/330 printer. 

The following pages describe the special configuration issues 
involved in printing to the ColorScript 310/330 printer from 
seven common graphics and page layout programs:

◆ Adobe Illustrator 4.0 on Page 89

◆ Adobe PageMaker 6.0 on Page 93

◆ Adobe Photoshop 3.0.5 on Page 99

◆ Corel Draw 5.0 (from Windows 3.1) on Page 102

◆ Corel Draw 6.0 (from Windows 95) on Page 109

◆ Macromedia Freehand 5.5 on Page 117

◆ Quark Express 3.3 on Page 123
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Adobe Illustrator 4.0

Before printing to the ColorScript 310/330 printer from Adobe 
Illustrator 4.0, you need to set up the ColorScript 310/330 
printer. If you have already set up the ColorScript 310/330 
printer, continue with this procedure. If you have not set up the 
printer, see “Setting Up the Printer” on Page 73 for instructions 
on setting up the ColorScript printer in Windows 3.1 or 
Windows 95.

To print to the ColorScript 310/330 printer from Adobe 
Illustrator 4.0:

1. Choose Page Setup from the File menu.

The Page Setup window displays, similar to the one shown 
in
Figure 5-8.

Figure 5-8  Adobe Illustrator 4.0 Print Setup Window
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2. Select the ColorScript 310/330 printer from the Specific 
printer pop-up menu if the ColorScript 310/330 printer 
is not your Default printer.

In a typical Windows environment, the default printer will 
be a monochrome LaserWriter or inkjet printer, and an 
advanced printer like the ColorScript 310/330 printer will 
be used only for color pre-press proofs.
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3. Verify that the Print Setup variables match your 
intended output.

Change any of the Print Setup variables to suit your needs:

• Page orientation

• Paper size

• Page source

4. When all the settings are correct, click OK to close the 
Print Setup window.

5. Choose Print from the File menu.

The Print window displays as shown in Figure 5-9.

Figure 5-9  Adobe Illustrator 4.0 Print Window

6. Verify that the Print window variables match your 
intended output.

Change any of the Print window variables to suit your 
needs:

• Number of copies

• Page range

• Font handling
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7. When you have set all the options to match your output 
requirements, click Print in the Print window.
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Adobe PageMaker 6.0

Before printing to the ColorScript 310/330 printer from Adobe 
PageMaker 6.0, you need to set up the ColorScript 310/330 
printer. If you have already set up the ColorScript 310/330 
printer, continue with this procedure. If you have not set up the 
printer, see “Setting Up the Printer” on Page 73 for instructions 
on setting up the ColorScript printer in Windows 3.1 or 
Windows 95.

To print to the ColorScript 310/330 printer from Adobe 
PageMaker 6.0:

1. Choose Document Setup from the File menu.

The Document Setup window displays, similar to the one 
shown in Figure 5-10.

Figure 5-10  Adobe PageMaker 6.0 Document Setup Window
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2. Verify that the Document Setup variables match your 
intended output characteristics.

Change any of the Document Setup variables to suit your 
needs:

• Page size

• Number of pages

• Margins

• Page orientation

• Output resolution

3. When all variables match your output requirements, 
click OK to close the Document Setup window.
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4. Choose Print from the File menu.

The Print Document window displays, similar to the one 
shown in Figure 5-11.

Figure 5-11  Adobe PageMaker 6.0 Print Document Window

5. Verify that the settings in the Print Document window 
match your intended output:

• Printer selection

• Number of copies 

• Page range

• Copy handling properties

• Page orientation
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6. Click Options to continue reviewing the document’s 
settings.

The Print Options window displays, similar to the one 
shown in Figure 5-12.

Figure 5-12  Adobe PageMaker 6.0 Print Options Window

7. Verify that the settings in the Print Options window 
match your intended output:

• Image reduction or enlargement

• Duplex handling

• Printer marks and page information

• Tiling
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8. Click Color to continue reviewing the document’s 
settings.

The Print Color window displays, similar to the one shown 
in 
Figure 5-13.

Figure 5-13  Adobe PageMaker 6.0 Print Color Window



Chapter 5 — Printing from Windows

98

9. Verify that the settings in the Print Color window match 
your intended output:

• Composite or Separations handling

• Printer halftones

• CMS Setup

10. When you have adjusted all settings to match your 
output requirements, click Print.

You can print from either the Print Document, Print Setup, 
Print Options, or Print Color windows.



Printing from Various Applications

99

Adobe Photoshop 3.0.5

Before printing to the ColorScript 310/330 printer from Adobe 
Photoshop 3.0.5, you need to set up the ColorScript 310/330 
printer. If you have already set up the ColorScript 310/330 
printer, continue with this procedure. If you have not set up the 
printer, see “Setting Up the Printer” on Page 73 for instructions 
on setting up the ColorScript printer in Windows 3.1 or 
Windows 95.

To print to the ColorScript 310/330 printer from Adobe 
Photoshop 3.0.5:

1. Choose Print from the File menu.

The Print window displays, similar to the one shown in 
Figure 5-14.

Figure 5-14  Adobe Photoshop 3.0.5 Print Window
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2. Verify that the Print window variables match your 
intended output:

Change any of the Print window variables to suit your 
needs:

• Page range

• Number of copies

• Copy handling

• Print resolution
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3. Click Setup to change the variables in the Page Setup 
window, shown in Figure 5-15:

• Printer selection

• Page orientation

• Paper size

• Paper source

• Screen, transfer, background, border, and bleed settings

• Calibration, registration, and crop marks

Figure 5-15  Adobe Photoshop 3.0.5 Page Setup Window

4. When all variables match your output requirements, 
click OK to close the Page Setup window.

5. When you have set all settings to match your output 
requirements, click Print in the Print window.
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Corel Draw 5.0 (from Windows 3.1)

Before printing to the ColorScript 310/330 printer from Corel 
Draw 5.0, you need to set up the ColorScript 310/330 printer. If 
you have already set up the ColorScript 310/330 printer, 
continue with this procedure. If you have not set up the printer, 
see “Setting Up the Printer” on Page 73 for instructions on 
setting up the ColorScript printer in Windows 3.1.

To print to the ColorScript 310/330 printer from Corel 
Draw 5.0:

1. Choose Print from the File menu.

The Print window displays, similar to the one shown in 
Figure 5-16.

Figure 5-16  Corel Draw 5.0 Print Window
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2. Verify that the Print window variables match your 
intended output.

Change any of the Print window variables to suit your 
needs:

• Page range

• Number of copies

• Printer selection

• Resolution

• Printer color profile selection

3. Click Setup to change the Printer Setup variables.

The Printer Setup window displays, similar to the one 
shown in Figure 5-17.

Figure 5-17  Corel Draw 5.0 Printer Setup Window 
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NOTE: Customized settings in the Print or Print Options windows 
can override settings in the Printer Setup window. The Printer Setup 
settings are the default settings for a new print job. Any changes you 
make in the Print or Print Options windows will affect only the 
current print job.

4. Verify that the Printer Setup variables match your 
intended output.

Change any of the Printer Setup variables to suit your 
needs:

• Paper source

• Paper size

• Page orientation

• Number of copies.

5. When all settings are correct, click OK to close the Page 
Setup window.
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6. Click Options in the Print window to change the Print 
Options window.

The Print Options window displays, showing the Layout tab 
variables similar to the example shown in Figure 5-18. 

Figure 5-18  Corel Draw 5.0 Layout Tab in the Print Options Window

7. Verify that the Layout variables match your intended 
output.

Change any of the Layout variables to suit your needs:

• Image position and size

• Layout style (tiling)
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8. When all layout settings are correct, click the 
Separations tab in the Print Options window. 

The Print Options window shows the Separations tab 
variables similar to the example shown in Figure 5-19. 

Figure 5-19  Corel Draw 5.0 Separations Tab in the Print Options Window

9. Verify that the Separations variables match your 
intended output.

Check the Print Separations checkbox to print each color 
individually. If you are printing separations, you have 
several additional options:

• You can print each separation in color

• You can convert spot colors to CMYK

• You can use a custom halftone



Printing from Various Applications

107

10. When all Separation settings are correct, click the 
Options tab in the Print Options window. 

The Print Options window shows the Options tab variables 
similar to the example shown in Figure 5-20. 

Figure 5-20  Corel Draw 5.0 Options Tab in the Print Options Window

11. Verify that the Options variables match your intended 
output.

Change any of the Options variables to suit your needs:

• Screen frequency

• Flatness

• Fountain steps 

• Maximum curve points

• Font handling
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12. When all Print Options settings are correct, click OK to 
close the Print Options window.

13. When you have set all the options to match your output 
requirements, click Print in the Print window.
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Corel Draw 6.0 (from Windows 95)

Before printing to the ColorScript 310/330 printer from Corel 
Draw 6.0,you need to set up the ColorScript 310/330 printer. If 
you have already set up the ColorScript 310/330 printer, 
continue with this procedure. If you have not set up the printer, 
see “Setting Up the Printer” on Page 73 for instructions on 
setting up the ColorScript printer in Windows 95.

To print to the ColorScript 310/330 printer from Corel 
Draw 6.0:

1. Choose Print from the File menu.

The Print window displays, similar to the one shown in 
Figure 5-21.
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Figure 5-21  Corel Draw 6.0 Print Window
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2. Verify that the Print window variables match your 
intended output.

Change any of the Print window variables to suit your 
needs:

• Printer selection

• Page range

• Number of copies

• Page handling

• Printer color profile
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3. Click Properties to change the Printer Properties 
variables.

The Printer Properties window displays, similar to the one 
shown in Figure 5-22.

Figure 5-22  Corel Draw 6.0 Printer Properties Window

NOTE: Customized settings in the Print or Print Options windows 
can override settings in the Printer Properties window. The Printer 
Properties settings are the default settings for a new print job. Any 
changes you make in the Print or Print Options windows will affect 
only the current print job.

4. Verify that the Printer Properties variables match your 
intended output.

Change any of the Printer Setup variables to suit your 
needs:

• Paper source

• Paper size

• Page orientation

• Number of copies
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5. When all Printer Properties settings are correct, click 
OK to close the Printer Properties window.

6. Click Options in the Print window to change the Print 
Options window.

The Print Options window shows the Layout tab variables 
similar to the example shown in Figure 5-23. 

Figure 5-23  Corel Draw 6.0 Layout Tab in the Print Options Window

7. Verify that the Layout variables match your intended 
output.

Change any of the Layout variables to suit your needs:

• Image position and size

• Layout style (tiling)
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8. When all layout settings are correct, click the 
Separations tab in the Print Options window. 

The Print Options window shows the Separations tab 
variables similar to the example shown in Figure 5-24. 

Figure 5-24  Corel Draw 6.0 Separations Tab in the Print Options Window

9. Verify that the Separations variables match your 
intended output.

Check the Print Separations checkbox to print each color 
individually. If you are printing separations, there are 
several other options:

• You can print each separation in color

• You can convert spot colors to CMYK

• You can use a custom halftone
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10. When all Separations settings are correct, click the 
Options tab in the Print Options window. 

The Print Options window shows the Options tab variables 
similar to the example shown in Figure 5-25. 

Figure 5-25  Corel Draw 6.0 Options Tab in the Print Options Window

11. Verify that the Options variables match your intended 
output.

Change any of the Options variables to suit your needs:

• Fountain steps

• Screen frequency

• PostScript preferences

• Proofing options

• Print job information handling
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12. When all Print Options settings are correct, click OK to 
close the Print Options window.

13. When you have set all the options to match your output 
requirements, click Print in the Print window.
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Macromedia Freehand 5.5

Before printing to the ColorScript 310/330 printer from 
Macromedia Freehand 5.5, you need to set up the ColorScript 
310/330 printer. If you have already set up the ColorScript 310/
330 printer, continue with this procedure. If you have not set up 
the printer, see “Setting Up the Printer” on Page 73 for 
instructions on setting up the ColorScript printer in 
Windows 3.1 or Windows 95.

To print to the ColorScript 310/330 printer from Macromedia 
Freehand 5.5:

1. Choose Output Options from the File menu.

The Output Options window displays, similar to the one 
shown in Figure 5-26.

Figure 5-26  Macromedia Freehand 5.5 Output Options Window
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2. Verify that the Output Options window variables match 
your intended output.

Change any of the Output Options window variables to suit 
your needs:

• RGB TIFF to CMYK conversion

• Maximum color steps

• Flatness

• Inclusion or exclusion of invisible layers

• Complex path treatment 

• Data encoding

3. When all the settings are correct, click OK to close the 
Output Options window.

4. Choose Printer Setup from the File menu.

The Printer Setup window displays, similar to the one 
shown in Figure 5-27.

Figure 5-27  Macromedia Freehand 5.5 Printer Setup Window (from File 
Menu)
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5. Select the ColorScript 310/330 printer in the Target 
Printer list box and click OK.
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6. Choose Print from the File menu.

The Print window displays, similar to the one shown in 
Figure 5-28.

Figure 5-28  Macromedia Freehand 5.5 Print Window

7. Verify that the Print window variables match your 
intended output.

Change any of the Print window variables to suit your 
needs:

• Image scale

• Tiling

• Page range
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8. Click Printer Setup in the Print window to change 
Printer and Page Setup options.

The Printer Setup window displays, similar to the one 
shown in Figure 5-29.

Figure 5-29  Macromedia Freehand 5.5 Printer Setup Window (from Print 
Window)

9. Verify that the Page Setup window variables match your 
intended output.

Change any of the Page Setup window variables to suit your 
needs:

• Paper source

• Paper size

• Paper orientation

• Number of copies



Chapter 5 — Printing from Windows

122

10. When all the settings are correct, click OK to close the 
Page Setup window.

The Printer Setup window displays.

11. When all the settings are correct, click OK to close the 
Printer Setup window.

The Print window displays.

12. When you have set all the options to match your output 
requirements, click Print in the Print window.
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Quark Express 3.3

Before printing to the ColorScript 310/330 printer from Quark 
Express 3.3, you need to set up the ColorScript 310/330 printer. 
If you have already set up the ColorScript 310/330 printer, 
continue with this procedure. If you have not set up the printer, 
see “Setting Up the Printer” on Page 73 for instructions on 
setting up the ColorScript printer in Windows 3.1 or 
Windows 95.

To print to the ColorScript 310/330 printer from Quark 
Express 3.3:

1. Choose Document Setup from the File menu.

The Document Setup window displays, similar to the one 
shown in Figure 5-30.

Figure 5-30  Quark Express 3.3 Document Setup Window
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2. Verify that the Document Setup variables match your 
intended output characteristics.

Change any of the Document Setup variables to suit your 
needs:

• Paper size

• Facing page handling

3. When all variables match your output requirements, 
click OK to close the Document Setup window.

4. Choose Print from the File menu.

The Print window displays, similar to the one shown in 
Figure 5-31.

Figure 5-31  Quark Express 3.3 Print Window
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5. Verify that the Print window variables match your 
intended output characteristics.

Change any of the Print window variables to suit your 
needs:

• Number of copies

• Page range

• Paper handling

• Tiling

• Separations

• Registration marks

• Color or grayscale (monochrome) printing

6. Click Setup in the Print window to change the Printer 
Setup variables, shown in Figure 5-32:

Change any of the Printer Setup variables to suit your 
needs:

• Printer selection

• Page size and orientation

• PDF selection

• EfiColor profile

• Halftone frequency

• Data format

• Image resolution and handling
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Figure 5-32  Quark Express 3.3 Printer Setup Window

7. When all variables match your output requirements, 
click OK to close the Printer Setup window.

8. When you have adjusted all settings to match your 
output requirements, click Print in the Print window.

Reprinting the Last Printed Page
You can press the Reprint button on the printer’s front panel to 
reprint the last page sent to the ColorScript 310/330 printer. 
This feature is useful for quickly printing several copies of a 
final proof once the output meets your requirements. This saves 
the processing time involved in sending another print job from 
your computer to the printer.
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The Reprint function prints only the last page printed, not the 
last print job, and several actions can prevent the printer from 
reprinting the last page:

◆ Turning off the printer

◆ Changing the ribbon type

◆ Changing the paper size

◆ Starting another print job

To reprint the last page printed:

◆ Press the Reprint button on the front panel of the 
ColorScript 310/330 printer.
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6
Upgrading Your Printer

This chapter describes how to upgrade your ColorScript 310/
330 printer to increase performance. Step-by-step instructions 
cover installing additional memory and installing an external 
hard disk for storing fonts.

Adding Memory to the Printer
Adding Random Access Memory (RAM) to the ColorScript 
310/330 printer is one of the best ways to improve print speed. 

NOTE: Adding memory yourself may void the ColorScript 310/
330 printer warranty. QMS Europe B.V. strongly recommends that 
you have a qualified service facility perform any internal hardware 
maintenance on your ColorScript 310/330 printer.
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Installing additional memory requires that the technician 
remove the ColorScript 310/330 printer’s logic board and add 
Single In-line Memory Modules (SIMMs) to the memory slots 
on the logic board. 

WARNING: Each pair of SIMMs must be of the same size 
and speed, and all SIMMS must be 72-pin, 32-bit (no parity) 
SIMMs, 70ns or faster.

In Table 6-1, QMS Europe B.V. recommends three standard 
memory configurations. Although other memory configurations 
are possible, these three memory configurations are the most 
common and most cost effective memory solutions for most 
printing requirements.

Table 6-1  Recommended Memory Configurations

Printer Model
Factory Installed 

Configuration
Maximum Practical 

Configuration
Maximum Possible 

Configuration

ColorScript 310 Bank 1 Bank 2 Bank 1 Bank 2 Bank 1 Bank 2

Empty

Total Memory: 16 MB 80 MB 128 MB

ColorScript 330 Bank 1 Bank 2 Bank 1 Bank 2 Bank 1 Bank 2

Empty

Total Memory: 32 MB 96 MB 128 MB

8 8 32 32 8 8 32 32 32 32

16 16 32 32 16 16 32 32 32 32
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NOTE: If you use 32 MB SIMMs in conjunction with smaller 
SIMMs, the 32 MB SIMMs must occupy Bank 1. See Figure 6-3 on 
Page 134 for SIMM slot locations.
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In addition to the materials that shipped with the ColorScript 
310/330 printer, you will need:

◆ A Phillips (star-head) screwdriver

◆ Two identical 72-pin, 32-bit (no parity) SIMMs, 70ns or 
faster

WARNING: The circuits and components on the printer’s logic 
board can be damaged by static electricity, or by connecting 
components incorrectly. Carefully review the entire procedure before 
you begin the installation process, and complete each step in the 
procedure before proceeding to the next step.

To install additional memory in the ColorScript 310/330 printer:

1. Turn off the ColorScript 310/330 printer.

2. Touch the metal surface of the back plate of the printer.

WARNING: Static electricity can build up in your body by 
walking on a carpet, or handling monitors, etc. When you touch a 
metal object, you may feel a small static shock. These static charges 
can damage or destroy electronic components and SIMMs on the 
printer’s logic board. Touching the printer’s metal frame while the 
printer is plugged into a grounded wall outlet safely discharges any 
static charge difference between you and the printer components. 

3. Unplug the printer from the electrical outlet.
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4. Use a Phillips screwdriver to remove the screws 
connecting the printer’s metal back plate.

The logic board is directly connected to the back plate of the 
printer.

Figure 6-1  Removing the Back Plate Screws

5. Pull the back plate and logic board out of the printer.

Grip the back plate by the grey plastic handle and pull 
straight back on the handle until the entire logic board is out 
of the printer.

Figure 6-2  Removing the Back Plate 

Back Plate Screws

Pull Straight out on HandleGrey Plastic Handle
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6. Place the logic board on a flat surface.

7. Identify the SIMM slots on the printer’s logic board. 

The SIMM slots are arranged in 2 banks of 2 slots each, as 
shown in Figure 6-3.

Figure 6-3  Locating the SIMM Slots on the Logic Board

8. Remove the new SIMMs from their static-proof bags.

SIMMs are shipped and stored in metallic static-proof bags. 
Keep these bags in case you need to remove the SIMMs 
from the printer later.

SIMM Slot 4

SIMM Slot 3

SIMM Slot 1

SIMM Slot 2
Bank 2 Bank 1
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9. Position the first SIMM at a 45° angle in the first 
available SIMM slot.

72-pin SIMMs have a notch slightly off center in the row of 
pins. If this notch does not fit directly over the matching 
ridge in the SIMM slot, rotate the SIMM 180° and try again.

Figure 6-4  Positioning the SIMM in the SIMM Slot

WARNING: Bank 1 must always be filled. Do not install SIMMs 
in Bank 2 only.

10. Press the SIMM into the SIMM clips.

Rotate the SIMM from 45° to 90° (vertical) and snap the 
SIMM securely into the SIMM clips.

11. Repeat Steps 9 and 10 for the second SIMM.

Add the SIMM to the other SIMM slot of the same bank. If 
you installed the first SIMM in slot 1, install the second 
SIMM in slot 2. If the first bank is already filled, and you 

SIMM Slot 1

SIMM Clip

SIMM

SIMM Slot 3

SIMM Clip

SIMM Slot 2SIMM Slot 4
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installed the first SIMM in slot 3, install the second SIMM in 
slot 4.

WARNING:  Always install SIMMs side by side in pairs, on one 
end of the slots or the other. Do not install SIMMS in the middle two 
slots only.

12. Slide the logic board back into the printer.

Position the corners of the logic board in the plastic rails 
and push the board straight into the printer. 

13. Replace the screws in the printer’s back plate.

Connecting an External Hard Disk to the Printer
The ColorScript 310/330 printer comes with a 540 MB internal 
SCSI hard disk for virtual memory and storing fonts. You can 
increase the printer’s font storage capacity by adding an external 
SCSI hard disk. 

In addition to the materials that came with the ColorScript 310/
330 printer, you will need:

◆ An external SCSI hard disk 

◆ A SCSI cable that matches the SCSI connector on the 
external hard disk on one end and has a 50-pin Centronics-
type connector on the other end

◆ A suitable power cord for the external hard disk

To add an external hard disk to your ColorScript 310/330 
printer:

1. Turn off your computer, the ColorScript 310/330 
printer, and the external hard disk.
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2. Identify an available SCSI ID for the external hard disk.

Each SCSI device attached to the ColorScript 310/330 
printer must have a unique SCSI ID number between 1 and 
6. The first external hard disk attached to the ColorScript 
310/330 printer must have SCSI ID 1. If you attach two or 
more external hard disks to the ColorScript 310/330 printer, 
assign each subsequent drive the next SCSI ID. 

Record the names of the hard drives you plan to attach to 
the ColorScript 310/330 printer in the Notes column of 
Table 6-2.

Table 6-2   Address Worksheet for Connecting an External Hard Disk to the 
Printer

SCSI 
ID Device Assignment Notes

0 Reserved for the Printer DO NOT USE THIS SCSI 
ADDRESS

1 First External Disk from the 
Printer

2 Second External Disk from the 
Printer

3 Third External Disk from the 
Printer

4 Fourth External Disk from the 
Printer

5 Fifth External Disk from the 
Printer

6 Sixth External Disk from the 
Printer

7 Reserved for the Printer DO NOT USE THIS SCSI 
ADDRESS
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WARNING: Use this table to assign a SCSI ID for an external 
hard disk only. Do not include information from any other SCSI 
devices attached to the computer.

3. Set the SCSI ID of the external hard disk to the number 
you selected in Step 2 of this procedure.

The SCSI ID switch on the external hard disk is a small, 
numbered switch or dial typically on the back or side of the 
hard disk case. Refer to the hard disk documentation if you 
cannot find the SCSI ID switch.
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4. Connect the 50-pin end of the SCSI cable to the 50-pin 
Centronics-type receiver on the back of the ColorScript 
310/330 printer.

Secure the connection with the mounting clips on the sides 
of the connector.

Figure 6-5  Connecting the SCSI Cable to the ColorScript 310/330 Printer

WARNING: Do not connect the external hard disk SCSI cable to 
the 50-pin HD-SCSI port on the ColorScript 310/330 printer. The 
HD-SCSI port is for SCSI printing only.

5. Connect the other end of the SCSI cable to the external 
hard disk.

The SCSI connector on the hard disk may be a 25-pin SCSI, 
50-pin Centronics-type SCSI, or a 50-pin HD-SCSI 
connector, depending on your type of hard disk connector.
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Figure 6-6  Typical SCSI Connectors

6. Attach the power cord to the external hard disk and 
plug the power cord into a power outlet.

7. Switch on the external hard disk.

8. Switch on the ColorScript 310/330 printer.

9. Switch on your computer to use the ColorScript 310/330 
printer with its external hard disk.

You may need to format the external hard disk before it can 
be used by the printer. Refer to the ColorScript Utilities 
documentation for instructions on formatting printer hard 
disks.

50-pin HD-SCSI25-pin SCSI50-pin Centronics
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Changing the SCSI ID of the Printer’s SCSI Input 
Port

Some SCSI printing environments may force you to change the 
ColorScript 310/330 printer’s SCSI input port SCSI ID from its 
default setting of SCSI ID 5. Changing the SCSI ID of the 
printer’s SCSI input port may help solve SCSI conflicts between 
multiple SCSI devices attached to your computer. To change the 
SCSI ID of the printer’s SCSI input port:

1. Turn off all SCSI devices connected to the ColorScript 
310/330 printer, then disconnect these devices from the 
printer.

2. Turn off your computer and the printer.

Disconnect the ColorScript 310/330 printer from your 
computer.

3. After all SCSI devices are turned off and disconnected 
from the ColorScript 310/330 printer, switch on the 
printer.

4. After the printer initializes, press the Menu key 
repeatedly until SCSI ID=5 displays in the LCD on the 
printer’s front panel.

The ColorScript 310/330 printer’s default SCSI input port 
ID is 5. If you have previously changed the SCSI input port 
ID, the number shown in the LCD will be different.

5. Press the Select button repeatedly until the SCSI ID you 
want to use displays in the LCD.

Wait for the LCD to time-out in a few seconds; the SCSI ID 
that was selected when the LCD timed out is set as the new 
SCSI ID. 

6. Turn off the ColorScript 310/330 printer and reconnect 
all SCSI devices.



Chapter 6 — Upgrading Your Printer

142

7. Reconnect the ColorScript 310/330 printer to your 
computer.

8. Switch on any connected SCSI devices, then switch on 
the printer.

9. Switch on your computer.
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7
Storing and Ordering Supplies

Storing Supplies
Dye sublimation paper and dye ribbons are susceptible to 
damage by heat, bright light, or excessive handling. Store your 
printer supplies according to the suggestions in the following 
sections.

Dye Sublimation Paper

Store unused dye sublimation paper in a cool, dry, flat place. Do 
not touch the shiny side of dye sublimation paper; oil from your 
fingerprints can stain the paper.

Dye Sublimation Ribbon

Dye sublimation ribbons can be damaged by heat, ultraviolet 
light, fingerprints, and moisture. Store dye sublimation ribbon 
in its original carton, in a cool, dark place. Be careful not to 



Chapter 7 — Storing and Ordering Supplies

144

expose the ribbon to excessive heat or bright light, including 
sunlight, and do not touch the print-side of the ribbon.

Storing Prints
Prints are prone to fading in ultraviolet light, including sunlight, 
and they are prone to marking by fingerprints, rubber erasers, 
and solvents. 

Ordering Parts and Supplies
You can order additional printer supplies by calling the QMS 
sales number listed on the last page of this manual. When 
ordering new supplies, make a note of the appropriate part 
numbers listed in Table 7-1, Table 7-2.

Table 7-1  Supplies for the ColorScript 310 Printer

Part Number  Description

1730300-001 Paper – A4, 3-Color

1730300-002 Paper– A4, 4-Color

1730300-003 Paper Super A, 3-Color

1730300-004 Paper Super A, 4-Color

1710229-001 Transparency Sheet, A4

1730310-001 Ink Ribbon, 3-Color

1730310-002 Ink Ribbon, 4-Color

1710228-001 Ink Ribbon Monochrome, A4

1710233-001 Ink, Ribbon, Cassette, CS310

1710234-001 Paper Cassette, CS310
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Table 7-2  Supplies for the ColorScript 330 Printer

Part Number  Description

1730300-001 Paper – A4, 3-Color

1730300-002 Paper– A4, 4-Color

1730300-003 Paper Super A, 3-Color

1730300-004 Paper Super A, 4-Color

1710229-001 Transparency Sheet, A4

1730400-001 Paper – A3, 3-Color

1730400-002 Paper– A3, 4-Color

1730400-003 Paper Super B, 3-Color

1730400-004 Paper Super B, 4-Color

1710231-001 Transparency Sheet, A4

1730410-001 Ink Ribbon, 3-Color

1730410-002 Ink Ribbon, 4-Color

1730230-001 Ink Ribbon Monochrome, A3

1710233-002 Ink, Ribbon, Cassette, CS330

1710234-002 Paper Cassette, CS330
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8
Maintaining and

Troubleshooting Your Printer

This chapter provides instructions for maintaining your 
ColorScript 310/330 printer so that it gives you years of trouble-
free service. Should problems arise, refer to the troubleshooting 
procedures in this chapter to resolve the problems quickly and 
efficiently.

Cleaning the Printer
Except for regular dusting of the printer, occasionally cleaning 
the thermal print head is the only maintenance needed.

Dusting the Printer

Keep the printer free of dust by dusting the printer occasionally 
with a clean, damp cloth.
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Cleaning the Thermal Print Head

If you notice a degradation in print quality, or if you see streaks 
in your images, you may need to clean the thermal print head 
using the ColorScript 310/330 cleaning pen. 

NOTE: Because of fire safety concerns, the ColorScript cleaning 
pen included with your printer ships without solvent. Fill the pen with 
100% isopropyl alcohol before using the cleaning pen.

To clean the thermal print head:

1. Open the top cover.

If the printer has been in operation, allow the print head to 
cool first.

2. Gently sweep the ColorScript cleaning pen along the 
length of the thermal print head several times in one 
direction. 

Allow the thermal print head to dry before closing the 
printer cover.

Servicing the Printer
There are no user-serviceable parts in the ColorScript 310/330 
printer. If the solutions discussed in this chapter do not resolve 
problems you are having, contact a qualified repair facility.
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Understanding the Printer Controls and Indicators
The front panel of the ColorScript 310/330 printer contains the 
printer’s status indicators and software controls. At startup, all 
status indicator lights will turn on. When the printer is ready to 
print, the red indicators will turn off and the green Ready icon 
will stay lit. If any of the red status indicators remain 
illuminated after startup, refer to “Status Indicator LEDs.”

Status Indicator LEDs

Some aspects of the printer’s status are communicated through 
LED icons on the front panel of the printer:

The Ready icon glows green to indicate that the printer is 
functioning normally.

The Paper jam icon glows red when there is a paper jam. If this 
icon is on, remove the paper tray, open the printer cover, remove 
the dye ribbon cassette, and remove the jammed paper.

The Replace Paper icon glows red when the printer is out of 
paper or there is a problem with the paper cassette. If this icon is 
on, make sure the paper cassette has paper or transparency film 
in it, and that the cassette is fully seated in the front of the 
printer. Refer to “Loading a Stack of Paper or Film” on Page 22 
for instructions on loading the paper cassette.

The Cover Open icon glows red when the printer cover is open. 
If this icon is on, make sure the cover is closed all the way. Refer 
to “Removing the Ribbon Cassette” on Page 30 for instructions 
on opening and closing the printer cover.

The Replace Ribbon icon glows red to indicate that the dye 
ribbon is exhausted. If this icon is on, open the printer cover, 
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remove the ribbon cassette, and replace the dye ribbon. Refer to 
“Removing the Ribbon Cassette” on Page 30 for instructions on 
changing the dye ribbon.
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LCD Messages

The LCD indicates the paper or transparency film size loaded in 
the paper cassette, and the type of ribbon installed in the printer. 
When the printer is ready to print, a message similar to 

READY SB 3C PS

displays in the LCD. The SB in this example stands for Super B 
media size, and the 3C in this example indicates that a 3-color 
(CMY) ribbon is loaded in the ribbon cassette. The PS indicates 
that the printer is ready to accept a PostScript job. The values in 
these fields will vary, depending on the paper or transparency 
film size and the type of ink ribbon installed in your printer. 
Table 8-1 explains the various LCD messages which may 
appear in this window. 

Table 8-1  LCD Panel Information Key 

LCD Readout Meaning

A A Size Media

A5 A5 Size Media

A3 A3 Size Media

A4 A4 Size Media

B B Size Media

3C CMY Ribbon

4C CMYK Ribbon

1C Monochrome 
Ribbon

PS Post Script Mode

RAST Raster Mode

SA Super A Size Media

SB Super B Size Media



Chapter 8 — Maintaining and Troubleshooting Your Printer

152

Keypad Controls

The functions controlled by the printer’s front panel keypad are 
described in relevant sections throughout this manual. The 
keypad controls include:

3. Reprint button

The Reprint button prints another copy of the last page 
printed on the ColorScript 310/330 printer. This feature is 
useful for quickly printing several copies of a final proof once 
the output meets your requirements. 

• Macintosh users refer to “Reprinting the Last Printed 
Page” on Page 71 for complete instructions. 

• PC users refer to “Reprinting the Last Printed Page” on 
Page 126.

◆ Menu button

The Menu button toggles between four different printer 
features that display in the front panel LCD window. Table 8-
2 briefly describes Menu button functions and references the 
relevant section in this manual. 

◆ Select button

The Select button toggles between different Menu button 
feature options described in Table 8-2. 

Table 8-2  Keypad Menu Controls

Press 
Menu 
Button

LCD Window 
Displays

Then Press Select 
Button to Select

See Instructions in 
Manual Section

Once Mode= PS (PostScript) or 
RAST (Raster)

“Changing to Raster Mode” 
on Page 17

Twice Monochrome ON or OFF “Printing in Monochrome 
Mode” on Page 35
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Three 
Times

SCSI ID= SCSI ID 0, 1, 2, 3, 4, 
5, or 6

“Changing the SCSI ID of the 
Printer’s SCSI Input Port” on 
Page 141

Four Times Config Print Prints Configuration 
Page

“Verifying Proper Operation” 
on Page 154

Table 8-2  Keypad Menu Controls

Press 
Menu 
Button

LCD Window 
Displays

Then Press Select 
Button to Select

See Instructions in 
Manual Section
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Verifying Proper Operation
When setting up your ColorScript 310/330 printer for the first 
time, or after transporting the printer to new location, you 
should test the printer to make sure the printer was not damaged 
in transit. This self-test checks the printer’s internal 
components, and prints a test page that provides information 
about the printer’s fonts, resolution, internal hard disk, and 
communication ports. 

To verify proper printer operation, issue a Config Print 
command using the printer keypad (see Figure 1-2 on Page 5.) 
To initiate the Config Print command:

1. Press the Menu button repeatedly until CONFIG 
PRINT appears in the LCD window. 

2. Press the Select key to start the self-test process.

There may be a slight delay before the printer starts printing 
the page. The printer status will return to ready after the 
Config Print page prints.
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Troubleshooting Interface Problems

Troubleshooting Print Quality Problems

Symptom Problem Solution

Config print page 
does not print.

PS not selected. Make sure Mode is set to PS.

Printer does not 
respond.

The printer is not turned on. Turn on the printer. The power switch is on the front of 
the printer in the lower left-hand corner.

Printer does not 
respond.

The printer is not properly 
connected.

Refer to “Connecting the Printer Cable” on Page 9 for 
detailed connection instructions.

Symptom Problem Solution

Prints are streaked 
or spotted.

The thermal print head is 
dirty.

Clean the thermal print head. Refer to “Cleaning the 
Thermal Print Head” on Page 148 for instructions.

The prints are 
smudged.

There are fingerprints on the 
paper and/or the printer 
ribbon.

◆ Refer to Chapter 2, “Loading Paper and Film.”

◆ Load the print cassette with clean paper. 

◆ Don’t touch the paper or ribbon before printing. 

◆ Press the Reprint button on the printer’s front panel 
to print another copy on the ribbon’s next color set.
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Troubleshooting Printer Error Messages

Message Problem Solution

Replace Paper There is no paper detected in 
the paper cassette, or the 
paper cassette is not fully 
seated in the printer.

Load paper into the paper cassette and reinsert the 
paper cassette. For detailed instructions, refer to 
Chapter 2, “Loading Paper and Film.”

Replace Ribbon The dye ribbon is exhausted. Replace the dye ribbon. Refer to Chapter 3, “Changing 
Printer Ribbons.”

Cover Open The printer cover is not 
completely closed.

Close the door. Press gently at the center of the door’s 
edge until it clicks shut.

Replace Cassette The cassette is not installed 
properly, or has been 
removed.

Replace the paper cassette. Refer to Chapter 2, 
“Loading Paper and Film” for details.

Paper Jam Paper is caught in the paper 
path.

Remove the paper from the path, then restore the 
ribbon and paper.
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A
Technical Specifications

General Specifications
Consult the following table for technical information on the 
ColorScript 310 and ColorScript 330 printers.

Table A-1  Specifications for the ColorScript 310 and ColorScript 330

Model ColorScript 310 ColorScript 330

Print Technol-
ogy

Dye Sublimation Transfer- 16.8 Million Colors

Resolution 300x300dpi (dots per inch)

Print Speed Approx. 130 sec.
(A4/A size, 3-color)

Approx. 180 sec. 
(A3/B size, 3-color)

Processor AMD 29030 clock speed: 33MHz
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Memory 16 MB Expandable to 128 
MB*

32 MB Expandable to 128MB*

Inwternal Hard 
Disk Drive

543MB (Proprietary Format)

Optional 
Interfaces*

Network option provides Ethernet, 
TCP/IP & Netware (10baseT/10base2 connectors)

Languages Adobe PostScript Level 2 (Macintosh and Windows drivers 
included)

QMS Raster Format (Macintosh and Windows Photoshop 
drivers included)

Color 
Management 
Support

Agfa™ FotoTune™, ICC Profiles, ColorSync, CIE Color

Standard Fonts Times®, Times-Bold, Times-Italic, Times BoldItalic

ITC Avant Guard®, ITC Avant Guard-Demi, ITC Avant Guard-
BookOblique, ITC Avant Guard-DemiOblique

Helvetica, Helvetica-Bold. Helvetica-Oblique, Helvetica-
BoldOblique

Helvetica-Condensed, Helvetica-Condensed-Bold, 
Helvetica-Condensed-Oblique, Helvetica-Condensed-

BoldOblique

Helvetica-Narrow, Helvetica-Narrow-Bold, 
Helvetica-Narrow-Oblique, Helvetica-Narrow-BoldOblique

Palatino, Palatino-Bold, Palatino-Italic, Palatino-BoldItalic

Courier, Courier-Bold, Courier-Oblique, Courier-BoldOblique

New Century Schoolbook, New Century Schoolbook-Bold, 
New Century Schoolbook-Italic, New Century Schoolbook-

BoldItalic

ITC Bookman®, ITC Bookman-Demi, 
ITC Bookman-LightItalic, ITC Bookman-DemiItalic

ITC Zapf Chancery®, ITC Zapf Dingbats®, Symbol

Table A-1  Specifications for the ColorScript 310 and ColorScript 330 

Model ColorScript 310 ColorScript 330
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*Installation by a qualified technician recommended.

Paper Cassette 
Capacity

50 Sheets

Ribbon 
Capacity

Monochrome—300 prints; 3-color—100 prints; 4 color—100 
prints

Power Source 
(Switch 
Selected)

AC100V~120V±10% or AC220V~240V±10% (48Hz~62Hz)

Max. Power 
Consumption

320W 375W

Operating 
Environment

50-95°F, 20%-80% Relative Humidity

Weight 62 lbs. (77lbs shipping) 71 lbs. (93lbs shipping)

Dimensions 16.1" (W) x 17.0" (D) x 13.0" 
(H)

18.9" (W) x 20.7" (D) x 13.0" 
(H)

Table A-1  Specifications for the ColorScript 310 and ColorScript 330 

Model ColorScript 310 ColorScript 330
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Imaging Area Specifications
Table A-2 and Table A-3 list imaging areas for various paper 
sizes in each printer model.

Table A-2  Imaging area for the ColorScript 310

Image Size Width Height

A5 5.6" (142.2mm) 7.3" (186mm)

A4 8" (203mm) 10.7" (273mm)

A 8.2" (208.6mm) 10" (255.4mm)

Super A 9.4" (238.5mm) 12.6" (320mm)

Table A-3  Imaging area for the ColorScript 330

Image Size Width Height

A4 8" (203mm) 10.7" (273mm)

A 8.2" (208.6mm) 10" (255.4mm)

Super A 9.9" (250.6mm) 13.4" (340mm)

A3 11.4" (290mm) 15.6" (396mm)

B 10.7" (270.9mm) 16.06" 
(407.7mm)

Super B 12.2" (308.9mm) 18" (457.2mm)
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Glossary

10Base-T Cable

10Base-T cable is a type of Ethernet connector and cable that is commonly used in 
both Macintosh and IBM-compatible PC networks. 10Base-T cable is also known 
as Category 5 wiring. See Figure 1-6 on page 9 for a comparison of the different 
types of connectors.

25-pin SCSI Connector

This common SCSI connector is the standard SCSI connector on Macintosh 
computers and on many SCSI adapters for IBM-compatible PCs. See Figure 6-6 on 
page 140 for a comparison of the different types of SCSI connectors.

50-pin High-Density (HD) SCSI Connector

Also known as SCSI-2, this type of SCSI connector is much smaller than other 
SCSI connectors. See Figure 6-6 on page 140 for a comparison of the different 
types of SCSI connectors.
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50-pin Centronics-type SCSI Connector

This common SCSI connector is the largest type of SCSI connector. See Figure 6-6 
on page 140 for a comparison of the different types of SCSI connectors. See 
“Category 5 Cable” on page 162.

Add-on Card

An electronic circuit card added to a slot in your computer that adds functionality to 
your computer. Add-on cards typically provide an Ethernet, video, or modem 
interface on the back of your computer.

AppleTalk

AppleTalk (also known as LocalTalk) is Apple Computer’s standard networking 
system that is built into every Macintosh computer. AppleTalk is a relatively slow 
interface that uses the printer port on the back of Macintosh computers. See 
Figure 1-6 on page 9 for a comparison of the different types of connectors.

ASCII Encoding

ASCII encoding sends information to the Colorscript 310/330 printer in a slower, 
but more compatible format than binary encoding. Some print servers, and some 
cross-platform printing environments require ASCII encoding.

ASPI

The Association of SCSI Peripheral Interface (ASPI) is a common SCSI interface 
standard that many SCSI adapters and SCSI devices meet. Your SCSI adapter or 
SCSI device documentation will indicate whether or not your hardware is ASPI-
compliant.

Binary Encoding

Binary encoding is the standard format for sending information to the Colorscript 
310/330 printer. Use binary encoding to print unless you have special print server 
or cross-platform printing requirements.

Category 5 Cable

See “10Base-T Cable” on page 161.

Centronics-type SCSI Connector

Although Centronics is a cable manufacturer, the Centronics name is used as an 
industry-standard term for a particular type of connector. See Figure 6-6 on 
page 140 for a comparison of the different types of SCSI connectors. See also “50-
pin Centronics-type SCSI Connector” on page 162.
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Cleaning Pen

Use the cleaning pen that ships with the Colorscript 310/330 printer to clean the 
printer’s thermal print head if you notice a degradation in print quality. Because of 
fire safety concerns, the cleaning pen ships without solvent. Fill the cleaning pen 
with 100% isopropyl alcohol before using the pen.

Coaxial Cable

See “Thinnet” on page 167.

Color Calibration

Agfa™ FotoTune™ software helps you calibrate your printer color with known 
image setters so that the color output from your Colorscript 310/330 printer 
matches the color of your final production output.

Dye Ribbon

The ink or dye used in the Colorscript 310/330 printer is dispensed from a ribbon 
that rides in a plastic ribbon cassette inside the printer.

Dye Sublimation Transfer Paper

The Colorscript 310/330 printer prints by evaporating colored dye from a mylar 
ribbon and transferring it onto special paper stock called dye sublimation paper. 

Ethernet

A common networking protocol used in both Macintosh and IBM-compatible PC 
networks. The hardware required for Ethernet networking may be built into your 
computer, or it may be on an add-on card. Ethernet connectivity is an option on the 
Colorscript 310/330 printer.

Hard Disk

A hard disk (also known as a disk drive or a hard drive) is a magnetic recording 
device used to store data. The Colorscript 310/330 printer has an internal hard disk 
that is used for virtual memory and to store fonts used by the Colorscript 310/330 
printer. You can add external hard disks to the Colorscript 310/330 printer to 
increase the printer’s font storage capacity.

Host Computer

A host computer is a computer that acts as an intermediary between a device like 
the Colorscript 310/330 printer and other computers on a network. You can connect 
your Colorscript 310/330 printer directly to a host computer and access the printer 
from other workstations on the host computer’s network.
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IBM-Compatible Computer

Also known simply as a PC, an IBM-compatible computer is a computer based on 
the x86 or Pentium™ processor. IBM-compatible computers are manufactured by 
IBM™, Compaq™, Hewlett-Packard™, Digital™, or many other companies, but 
not Apple Computer, Inc. 

LCD

The liquid crystal display (LCD) window on the printer’s front panel displays 
information about the printer’s status. Refer to “LCD Messages” on page 151 for a 
description of LCD messages.

LED

A light emitting diode (LED) is a small light that indicates the printer’s status. 
Refer to “Status Indicator LEDs” on page 149 for a description of LED indicators.

LocalTalk

See “AppleTalk” on page 162.

Logic Board

Most electronic devices, such as computers and printers, have a logic board that 
contains the device’s main electronic circuitry. To add memory to your printer, you 
will need to remove the Colorscript 310/330 printer’s logic board and add RAM 
SIMMs to the SIMM slots on the logic board.

Macintosh Computer

Also known simply as a Mac, most Macintosh computers are manufactured by 
Apple Computer, Inc. Although Macintosh® is a registered trademark of Apple 
Computer, Inc., several companies now manufacture “Macintosh clone” computers 
that run the Macintosh Operating System. Macintosh clone computer users should 
follow the instructions for Macintosh computers throughout this manual.

Media

Both dye sublimation transfer paper and transparency film are usable media for the 
Colorscript 310/330 printer. Because the Colorscript 310/330 printer can print to 
both paper and transparency film, the term media is used throughout this manual to 
mean either paper or transparency film.

Network Zone

Zones are divisions of a network that are used to organize the network or make the 
network more efficient.
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Parallel Port Connector

The parallel port connector is the primary printer connector on IBM-compatible 
PCs.

Parity

Some SIMMs, particularly those used in older PC-compatible computers, use an 
additional chip called a parity chip. The parity chip verifies data integrity of the 
information stored on the SIMM. The Colorscript 310/330 printer does not use 
parity SIMMs, so be sure to use non-parity SIMMs in the Colorscript 310/330 
printer.

PostScript

Adobe Systems, Inc. developed the PostScript language that computers use to 
communicate with all PostScript-compatible printers like the Colorscript 310/330 
printer.

PPD

A PostScript Printer Description (PPD) is software that enables your computer to 
communicate properly with a PostScript printer.

RAM

Random access memory (RAM) is memory that holds active data used in 
processing computer functions. In the Colorscript 310/330 printer, RAM is 
installed in slots on the logic board. Refer to “Adding Memory to the Printer” on 
page 129 for details on adding RAM to your Colorscript 310/330 printer.

Raster Mode

Data in Raster format is data that is described by individual pixels. A Raster file is 
also known as a bitmap file. The Colorscript 310/330 printer can print in Raster 
mode from raster applications such as Adobe Photoshop.

SCSI

Small Computer System Interface (SCSI) is the standard hardware interface on 
Macintosh computers, and it is a common hardware interface for IBM-compatible 
computers. SCSI ports always have either 25 or 50 pins, but not all 25-pin ports are 
SCSI ports; parallel ports in IBM-compatible computers also have 25 pins, so be 
sure to accurately identify the ports on your computer.

SCSI-2 Connector

See “50-pin High-Density (HD) SCSI Connector” on page 161.
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SCSI Address

Each SCSI device attached to a computer must have a unique SCSI address—a 
number between 0 and 6. Refer to “SCSI Connections” on page 13 and “Changing 
the SCSI ID of the Printer’s SCSI Input Port” on page 141 for more details.

SCSI Bus

A chain of SCSI devices, including internal and external devices, that are physically 
connected to the same SCSI port.

SCSI Chain

See “SCSI Bus.”

SCSI Device

A peripheral device such as a CD-ROM drive, a hard disk, or a scanner that uses the 
SCSI interface to connect to the host computer.

SCSI ID

See “SCSI Address.”

SCSI Port

The physical connector for attaching one SCSI device to another SCSI device.

SCSI Printing

When using a SCSI printer driver, you can speed up printing from Raster (bitmap) 
applications like Adobe Photoshop by printing via a SCSI connection to a SCSI 
printer, like the Colorscript 310/330 printer.

Serial

A standard communications interface used for software maintenance on the 
Colorscript 310/330 printer.

SIMM

A Single Inline Memory Module (SIMM) is a physical component of RAM that can 
be purchased separately and added to the Colorscript 310/330 printer to increase 
printer performance. See “RAM” on page 165.
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SIMM Bank

A SIMM bank is a grouping of SIMM slots.There are two SIMM banks in the 
Colorscript 310/330 printer; each bank consists of two SIMM slots. When adding 
memory to the Colorscript 310/330 printer, you must fill each bank completely, 
with two identical SIMMs. See “Adding Memory to the Printer” on page 129.

SIMM Slot

A SIMM slot is the physical receptacle on the logic board that holds RAM SIMMs.

Thermal Print Head

The thermal print head is the mechanism in the Colorscript 310/330 printer that 
heats to evaporate dye from the dye ribbon in the printing process.

Thinnet

Thinnet cable is a type of Ethernet connector and cable that is commonly used in 
IBM-compatible PC networks. Thinnet cable is also known as coaxial cable. See 
Figure 1-6 on page 9 for a comparison of the different types of connectors.

Transparency Film

Special transparency film can be used in the Colorscript 310/330 printer to print 
color overhead projections.

Virtual Memory

The Colorscript 310/330 printer uses virtual memory to temporarily store 
information on a hard disk instead of storing the information in RAM. 

Zone

See “Network Zone” on page 164.



Glossary

168

This page is intentionally left blank.



169

Index

Numerics
10Base-T Ethernet connector 9
50-pin HD-SCSI connector 9
50-pin SCSI port 13

A
Adding memory 129–136
Adjusting paper size 27
Adobe

Illustrator 4.0 (Windows) 89–92
Illustrator 5.5 (Mac OS) 46–49
PageMaker 6.0 (Mac OS) 50–56
PageMaker 6.0 (Windows) 93–98
Photoshop 3.0 (Windows) 99–101
Photoshop 3.0.5 (Mac OS) 57–59

ASCII Encoding 59

B
Back panel connectors 5
Binary encoding 59

C
Cables

printer 9
Calibrating

color (Mac OS) 44
color (Windows) 87

Capacity
paper cassette 22

Changing
internal disk SCSI ID 141
printer ribbons 29

Cleaning
print head 148
your printer 147

Color 21
calibration (Mac OS) 44
calibration (Windows) 87

Config print command 154
Configuring the printer (Mac OS) 38–43
Connecting

external hard disk 136–140
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power cord 8
printer and computer 11
printer cable 9

Connectors 5
10Base-T Ethernet 9
50-pin HD-SCSI 9, 13
Ethernet 11
external hard disk 136–140
LocalTalk 9, 11
parallel port 9, 13
Thinnet Ethernet 9

Corel
Draw 5.0 (Windows 3.1) 102–108
Draw 6.0 (Windows 95) 109–116

Cover open message 156

D
Dusting your printer 47
Dye Ribbon icon 149
Dye sublimation paper 143

E
Encoding

ASCII 59
binary 59

Errors
cover open 156
mechanical error 156

Ethernet connectors 11
External hard disk 136–140

F
Film

changing film size 27
feeding manually 27
loading a stack 22
size 21

Fingerprints 144
Front panel buttons and indicators 5

H
Hard disk

external 136

internal 158

I
IBM-compatible PC connections 10
Installing

printer 1–18
printing software (Mac OS) 37–38
printing software (Windows 3.1) 74–78
printing software (Windows 95) 79
ribbon cassette 32

Internal hard disk 158

L
LCD panel 151
LEDs 149
Loading 21

film 21–27
paper 21–27

LocalTalk connector 9, 11

M
Macintosh connections 10
Macromedia

Freehand 5.5 (Mac OS) 60–65
Freehand 5.5 (Windows) 117–122

Maintaining your printer 147–154
Manual feed tray 27
Mechanical error 156
Media Detect switch 27
Memory

adding 129–136
standard memory configurations 130

Monochrome ribbon 29, 35

O
Opening the printer cover 30
Ordering supplies 144

P
Padding in paper and ribbon areas 4
Paper

cassette capacity 22
cassette parts 6, 23
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changing paper size 27
dye sublimation 143
feeding manually 27
Jam icon 149
jams 33, 149
loading a stack 22
Out icon 19, 149
size 21

Parallel port connector 9, 13
Parts

paper cassette 23
printer 5

PostScript mode 18
Power cord 8
Powering the printer on 18
Print head 148
Printer

10Base-T Ethernet connector 9
50-pin HD-SCSI connector 9
50-pin SCSI port 13
adding memory 129–136
cable 9
changing ribbon 29
changing the ribbon 30
cleaning the print head 148
color calibration (Mac OS) 44
color calibration (Windows) 87
config (test) page does not print 155
configuring (Mac OS) 38–43
configuring (Windows 3.1) 74–78
configuring (Windows 95) 79
connecting to computer (Non-SCSI) 11
connecting to external hard disk 136–140
connecting to power 8
connectors 5
controls and indicators 149
dusting 147
front panel buttons and indicators 5
installing 1–18
installing a new ribbon 32
internal hard disk 141
LCD panel 151
LEDs 149
loading film and paper 21–27

LocalTalk connector 9, 11
maintaining 147–154
not responding 155
Open icon 149
opening top cover 30
paper cassette 6
parallel port connector 9
parts 5
print quality problems 155
ribbon types 29
SCSI connection 10
SCSI ID of internal hard disk 141
selection (Mac OS) 38–40
self-test 154
servicing 148
setting voltage 7
setup

Mac OS 40–43
site requirements 1
start-up sequence 18
test page 154
thermal print head 31
Thinnet Ethernet connector 9
troubleshooting 149
unpacking 2
verifying proper operation 154

Printing
from Adobe Illustrator 4.0 
(Windows) 89–92
from Adobe Illustrator 5.5 (Mac OS) 46–

49
from Adobe PageMaker 6.0 
(Mac OS) 50–56
from Adobe PageMaker 6.0 
(Windows) 93–98
from Adobe Photoshop 3.0 
(Windows) 99–101
from Adobe Photoshop 3.0.5 
(Mac OS) 57–59
from Corel Draw 5.0 
(Windows 3.1) 102–108
from Corel Draw 6.0 
(Windows 95) 109–116
from IBM-compatible PCs 10, 17
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from Macromedia Freehand 5.5 
(Mac OS) 60–65
from Macromedia Freehand 5.5
(Windows) 117–122
from Quark Express 3.3 (Mac OS) 66–70
from Quark Express 3.3 
(Windows) 123–126
from the Macintosh 10, 17

reprinting the last printed page 71
from various applications (Mac OS) 45–70

Adobe Illustrator 5.5 46–49
Adobe PageMaker 6.0 50–56
Adobe Photoshop 3.0.5 57–59
Macromedia Freehand 5.5 60–65
Quark Express 3.3 66–70

from various applications 
(Windows) 88–126

Adobe Illustrator 4.0 89–92
Adobe PageMaker 6.0 93–98
Adobe Photoshop 3.0 99–101
Corel Draw 5.0 102–108
Corel Draw 6.0 109–116
Macromedia Freehand 5.5 117–122
Quark Express 3.3 123–126

from Windows 10, 17
reprinting the last printed page 126

monochrome mode 35
monochrome ribbon 29
software (Mac OS) 37–38
software (Windows 3.1) 74–78
software (Windows 95) 79

Prints
smudged 155
storing 144
streaked or spotted 155

Q
Quark

Express 3.3 (Mac OS) 66–70
Express 3.3 (Windows) 123–126

R
Raster mode 17
Ready icon 149

Removing
ribbon 30
ribbon cassette 30

Removing the ribbon 32
Reprinting the last printed page 71, 126
Ribbon

conserving 35
installing the cassette 32
monochrome 35
Out 149
Out icon 19, 149
removing 30, 32
removing the cassette 30
replacing 29
slack 33
storing 143
types 29

S
SCSI connection 13
SCSI devices 17, 141
SCSI IDs 14

external hard disks 137
IBM-compatible PC users 15
internal hard disk 141
Macintosh users 15

SCSI printer drivers 13
SCSI printing 10, 17
Selecting the printer (Mac OS) 38–40
Self-test 154
Servicing your printer 148
Setting

printer voltage 7
Setting up

printing software
Windows 3.1 74–78
Windows 95 79

the printer
Mac OS 40–43

Start-up sequence 18
Status Indicator LEDs 149
Storing

paper 143
prints 144
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ribbon 143
supplies 143

Supplies
ordering 144
storing 143

T
Thermal print head 31
Thinnet Ethernet connector 9
Troubleshooting 149

U
Unpacking 2
Upgrading your printer 129–142

V
Verifying proper operation 154
Voltage switch 7
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Disclaimer

This User’s Guide is provided to help you install and use the 
ColorScript 310/330 printer.

The specifications in this user’s guide are subject to change without prior 
notice.

QMS Europe B.V. assumes no responsibility for direct, indirect, special, 
contingent, or inevitable damage caused by any error or misprint in this 
user’s guide.

FCC Warning

Radio Frequency Interference Statement

This equipment has been tested and found to comply with the limits for a 
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful interference 
when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy, and if 
not installed and used in accordance with this user’s guide, may cause 
harmful interference to radio communications. Operation of this equipment 
in a residential area is likely to cause harmful interference, in which case 
the user will be required to correct the interference at her or his own 
expense.

Trademarks & Copyright 

All rights reserved. No part of this user’s guide covered by the copyright 
herein may be reproduced or copied in any form or by any means, including 
translation, without the written permission of QMS Europe B.V.

Copyright 1996 by QMS Europe B.V.

Adobe and PostScript are trademarks of Adobe Systems Incorporated, 
which may be registered in certain jurisdictions.

Times, Helvetica, and Palatino are trademarks of Linotype AG and/or its 
subsidiaries.

ITC Avant Garde, ITC Zapf Chancery, ITC Zapf Dingbats, and ITC 
Bookman are registered trademarks of International Typeface Corporation.



Apple, AppleTalk, and Macintosh are registered trademarks of Apple 
Computer, Inc.

Microsoft, Windows and other names of Microsoft products referenced in 
this user’s guide are trademarks or registered trademarks of Microsoft 
Corporation.

Agfa and FotoTune are trademarks of Bayer Corporation or its affiliates, 
which may be registered in certain jurisdictions.

All other product and company names mentioned in this user’s guide are the 
trademarks of their respective owners. 

Contacting QMS Europe B.V.

Sales, technical support, and general information for the 
ColorScript 310/330 printer is available via the telephone, 
email, World Wide Web, and regular mail.

QMS Europe B.V.
Reactorweg160
3542 AD Utrecht
The Netherlands
+31 30 248 1200

World Wide Web

http://www.qms.nl

Sales

Phone: +31 34 655 1333



Toll free helpdesk support:

Germany call 0130 829413
The Netherlands call 0800 0226550
United Kingdom call 0800 964092

Document History

Part Number 1800380-001
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March, 1997



This page is intentionally left blank.


	ColorScript 310/330 Printer 
	Preface
	Table of Contents
	1 Installing Your Printer
	Finding a Location for the Printer
	Unpacking the Printer
	Setting the Printer Voltage Switch
	Connecting the Power Cord
	Connecting the Printer Cable
	Switching the Printer On

	2 Loading Paper and Film
	Loading a Stack of Paper or Film
	Using the Manual Feed Tray

	3 Changing Printer Ribbons
	Removing the Ribbon Cassette
	Installing a New Ribbon
	Printing in Monochrome Mode

	4 Printing from the Mac OS
	Installing the Printing Software
	Configuring the Printer
	Calibrating Color
	Printing from Various Applications
	Adobe Illustrator5.5
	Adobe PageMaker6.0
	Adobe Photoshop3.0.5
	Macromedia Freehand5.5
	Quark Express3.3

	Reprinting the Last Printed Page

	5 Printing from Windows
	Setting Up the Printer
	Calibrating Color
	Printing from Various Applications
	Adobe Illustrator4.0
	Adobe PageMaker6.0
	Adobe Photoshop3.0.5
	Corel Draw5.0 (from Windows3.1)
	Corel Draw6.0 (from Windows95)
	Macromedia Freehand5.5
	Quark Express3.3

	Reprinting the Last Printed Page

	6 Upgrading Your Printer
	Adding Memory to the Printer
	Connecting an External Hard Disk to the Printer
	Changing the SCSI ID of the Printer’s SCSI Input port

	7 Storing and Ordering Supplies
	Storing Supplies
	Storing Prints
	Ordering Parts and Supplies

	8 Maintaining and Troubleshooting Your Printer
	Cleaning the Printer
	Servicing the Printer
	Understanding the Printer Controls and Indicators
	Verifying Proper Operation
	Troubleshooting Interface Problems
	Troubleshooting Print Quality Problems
	Troubleshooting Printer Error Messages

	A Technical Specifications
	General Specifications
	Imaging Area Specifications

	Glossary
	Index
	Disclaimer
	Contacting QMS Europe B.V.

